
Categories and Keywords for All Knowledge Base Articles
Article ID: Q94671
CATEGORIES AND KEYWORDS FOR ALL KNOWLEDGE BASE ARTICLES
=======================================================

To categorize articles within the Microsoft Knowledge Base and make finding
information easier, a common set of keywords has been adapted for use
throughout the KB. These keywords are used to categorize the subject of
each article. Each article has one SUBJECT keyword. A secondary keyword
indicating the TYPE of article can also be used.

To query on one category, enter the category code and a wildcard. For
example:

   kb3rdparty*

To query on more than one category, enter each category code with a
wildcard. For example:

   kb3rdparty* or kbinterop* or kbusage*

To query on one subcategory, enter the complete code. For example:

   kbbuglist

To query on more than one subcategory, enter all the complete codes. For
example:

   kbbuglist or kbfixlist

You can also mix categories and subcategories in one query. For example:

   kbtshoot or kbnetwork*

NOTE: At the end of this article is a table that lists formerly used
keywords and their replacements.

INFORMATION CATEGORIES AND KEYWORDS
===================================

   Article subject                                       Keyword
   ----------------------------------------------------------------

   Interactions with third-party products                kb3rdparty
   Interoperability with other MS products               kbinterop
   How to use product features/functionality             kbusage
   Printing                                              kbprint
   Setup and installation issues                         kbsetup
   Networking                                            kbnetwork
   Environment and configuration information             kbenv
   OLE technology                                        kbole
   Tools, utilities, applets, such as MS Draw or Write   kbtool
   Programming                                           kbprg
   User interface                                        kbui
   Graphics                                              kbgraphic



   Multimedia                                            kbmm
   Hardware                                              kbhw
   Microsoft At Work                                     kbatwork
   Sound (audio) issues                                  kbsound
   Display (video, monitor, resolution) issues           kbdisplay
   Readme files                                          kbreadme
   Lists of vendor phone numbers, disk directory
      listings, other lists or references                kbref
   Support boundaries, policies, processes
      & procedures                                       kbpolicy
   Other: Any subject not covered in other categories    kbother

   Article types                                         Keyword
   ----------------------------------------------------------------

   Application Notes                                     kbappnote
   Bug info for a particular version of a product        kbbuglist
   Sample code                                           kbcode
   Documentation errors                                  kbdocerr
   Error message followup information                    kberrmsg
   FastTip scripts or maps                               kbfasttip
   Binary file information located in the
      Microsoft Software Library                         kbfile
   Fixed bug info for a particular version of
      a product                                          kbfixlist
   Articles listing product-specific keywords            kbkeyword
   Sample macro with article                             kbmacro
   Problems not classified as bugs                       kbprb
   FastTip Technical Library Catalog                     kbtlc
   Troubleshooting information                           kbtshoot

The following table lists formerly used keywords and their replacements.
For explanations of what these keywords represent, see the tables above.

   Old keyword(s)                                        New keyword
   -----------------------------------------------------------------

   3rdparty, isv, 3rd party                              kb3rdparty
   phoneref, diskdir                                     kbref
   errmsg, err msg                                       kberrmsg
   docerr, doc err                                       kbdocerr
   buglist                                               kbbuglist
   fixlist                                               kbfixlist
   softlib                                               kbfile
   tshoot                                                kbtshoot
   appnote                                               kbappnote
   fasttip, ivr                                          kbfasttip
   tlc                                                   kbtlc

MORE INFORMATION
================

Future querying tools may allow for use of friendly names for information
categories. With current searching tools, "printing" cannot be used as a
keyword because that word is also used in many articles whose main subject
is not printing. Until our tools allow searching on keywords separately
from article text, we need to create unique spellings for Knowledge Base



keywords. Therefore, all standard Knowledge Base keywords will begin with
the letters "kb."

Additional reference words: kbkeyword key word kbcdg dskbguide
KBCategory: kbref
KBSubcategory:



 Word Query Keywords for the Knowledge Base
Article ID: Q123901
The information in this article applies to:

 - Microsoft Word for Windows, version 6.0, 6.0a, 6.0c
 - Microsoft Word for the Macintosh, version 6.0
--------------------------------------------------------------------

SUMMARY
=======

You can use keywords to easily query for specific topics in the Microsoft
Knowledge Base. This article contains keywords specifically for Microsoft
Word for Windows, and Word for the Macintosh. By using these keywords, you
can quickly access common topics. These keywords are commonly found at the
bottom of articles following the word, KBSubcategory. For a list of
categories and keywords universal to all knowledge base articles see
Q94671.

MORE INFORMATION
================

Subject                  Key word
-------                  --------

Bullets, Numbering       kbnumbering
Envelopes                kbenvelope
Fields                   kbfield
Fonts                    kbfont
Formatting               kbformat
Formulas                 kbformula
Frames                   kbframe
Glossaries, Autotext     kbautotext
Help/CBT                 kbhelp
General layout           kblayout
Macro examples           kbmacroexample
Mail merge               kbmerge
Proofing tools           kbproof
Tables                   kbtable
Templates                kbtemplate

KBCategory: kbkeyword kbtshoot
KBSubcategory:
Additional reference words: 6.00 6.00a 6.00c 2.00 2.00a 2.00a-CD 2.00b
2.00c word troubleshooting



 Word for Windows 95 Install Files List
Article ID: Q116728
-------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
-------------------------------------------------------------------------

SUMMARY
=======

This article contains the list of files installed under the various setup
options with Word for Windows or after installing Word from Office.

Note: Laptop indicates the minimum installation and is always included in a
Typical installation. Complete/Custom denotes that the feature must be
selected before it is installed.

                                                   Setup         Additional
Parts     File Name       Directory                Option        Comments
===========================================================================

Word 95
-------
          winword.exe     winword                  Laptop
          winword7.reg    winword                  Laptop
          wwintl32.dll    winword                  Laptop
          ctl3d32.dll     system32                 NT Laptop     NT Only.
          ttemb32.dll     system32                 Laptop
          dialog.fon      winword                  Laptop
          ttembed.ini     windows                  Laptop
          msfntmap.ini    windows                  Laptop

Office
------
          mso95.dll       system32                 Laptop
          mso5enu.dll     system32                 Laptop
          mso95fx.dll     system32                 Laptop
          msothunk.dll    system32                 Laptop
          docobj.dll      system32                 Laptop

Office Open
-----------
          openenu.dll     system32                 Laptop
          findfast.cpl    system32                 Laptop
          findfast.exe    msoffice\office          Laptop
          fastboot.exe    msoffice\office          Laptop
          ffastlog.txt    windows                  Laptop
          ffast_bb.dll    ???????                  Laptop
MapiVim
-------
          mapivi32.dll    system32                 VIM Laptop
          mapivitk.dll    system32                 VIM Laptop

AutoCorrect List
----------------



          msoffice.acl    windows                  Laptop
Misc.
-----
Button Editor
          commtb32.dll    system32                 Laptop
MS Toolbar
          mstool32.dll    system32                 Laptop

Setup
-----
          exract.exe      msoffice\office\setup
          setup.exe
          setup.ini
          setup.lst
          setup.tdf
          wrd95.inf
          wrd95.stf
          acme.exe
          acmsetup.exe
          acmsetup.hlp
          admin.inf
          mssetup.dll
          off95_bb.dll
          offsetup.ttf    bootsrtap only
          wrd95.pdf
          wrd95inv.dll
          wrdacme.lst

Help
-----
          winword.hlp     winword                  Typical
          winword.cnt     winword                  Typical
          winword.fts     winword                  Typical
          winword.gid     winword                  Typical
          wkeyword.fts    winword                  Typical
          wkeyword.hlp    winword                  Typical
          qwinword.hlp    winword                  Typical
          qwinword.fts    winword                  Typical
          wrdbasic.hlp    winword                  Complete/Custom
          wrdbasic.cnt    winword                  Complete/Custom
          wrdbaisc.fts    winword                  Complete/Custom
          wrdbasic.gid    winword                  Complete/Custom
          pss.hlp         msoffice\office          Laptop
          pss.cnt         msoffice\office          Laptop
          psso.hlp        msoffice\office          OEM Laptop
          psso.cnt        msoffice\office          OEM Laptop
          eula.cnt        msoffice\office          Laptop
          eula.hlp        msoffice\office          Laptop
          eulao.cnt       msoffice\office          OEM Laptop
          eulao.hlp       msoffice\office          OEM Laptop
          qoffice.hlp     winword                  Typical
          wdvisex.exe     winword                  Typical
          Visx.exe        winword                  Typical
          visxutil.dll    winword                  Typical
          hlp95en.dll     winword                  Typical
          winword.aw      winword                  Typical
          wrdbasic.aw     winword                  Complete/Custom



          vbrun300.dll    windows\system           Typical
          wdreadme.txt    winword                  Laptop
          network.txt     Not Installed            Laptop
          hatten.ttf      system                   Typical

WP Help
-------
          wphelp.hlp      winword                  Complete/Custom

Proofing Tools
--------------
Speller
          mssp232.dll     msapps\proof             Laptop
          mssp2_en.lex    msapps\proof             Laptop
          mssp2_ea.lex    msapps\proof             AA Laptop    AA only
          custom.dic      msapps\proof             Laptop       0 byte
                                                                 default
Hyphenation
          hyph32.dll      winword                  Typical
          hy_en.lex       winword                  Typical

Thesaurus: (Soft Art All lang except below)
          msth32.dll      msapps\proof             Typical
          msth_am.lex     msapps\proof             Typical
          msth_br.lex     msapps\proof             Z AA Typical  Z and AA
                                                                 only
Grammar: (HM for ENG)
          gram32.dll      winword                  Complete/Custom
          gr_am.lex       winword                  Complete/Custom
          gr_br.lex       winword                  Z AA Complete/Custom
                                                                 Z and AA
                                                                 only
Find all Word Forms - US and UK English
          mswds_en.lex          winword            Complete/Custom

Dialog Editor
-------------
          macrode.exe     winword                  Complete/Custom

Graph 5.0
---------
          graph5.exe      msapps\msgraph           Complete/Custom
          grintl.dll      msapps\msgraph           Complete/Custom
          scp.dll         system                   Complete/Custom
          sdm.dll         system                   Complete/Custom
          gren50.olb      msapps\msgraph           Complete/Custom
          msgraph.hlp     msapps\msgraph           Complete/Custom
          msgraph.fts     msapps\msgraph           Complete/Custom
          msgraph.gid     msapps\msgraph           Complete/Custom
          graph5.reg      msapps\msgraph           Complete/Custom

WordArt
-------
          wrdart32.exe    msapps\wordart           Complete/Custom
          pubole32.dll    system32                 Complete/Custom
          wrdart32.reg    msapps\wordart           Complete/Custom
          wrdart32.hlp    msapps\wordart           Complete/Custom



          wrdart32.cnt    msapps\wordart           Complete/Custom
          wrdart32.gid    msapps\wordart           Complete/Custom
          wrdart32.fts    msapps\wordart           Complete/Custom
          qwrdrt32.hlp    msapps\wordart           Complete/Custom
          qwrdrt32.fts    msapps\wordart           Complete/Custom

TT Fonts
--------
Algerian  alger.ttf       system                   Complete/Custom
Arial Narrow
          arialn.ttf      system                   Typical
Arial Black
          ariblk.ttf      system                   Typical
Arial Rounded MT Bold
          arlrdbd.ttf     system                   Typical
Bookman Old Style
          bookosb.ttf     system                   Complete/Custom
Braggadocio
          bragga.ttf      system                   Complete/Custom
Britannic Bold
          britanic.ttf    system                   Complete/Custom
Brush Script MT
          brushsci.ttf    system                   Complete/Custom
Colonna MT
          colonna.ttf     system                   Complete/Custom
Desdemona
          desdemon.ttf    system                   Complete/Custom
Footlight MT Light
          ftltlt.ttf      system                   Complete/Custom
Garamond  gara.ttf        system                   Typical
Garamond  garabd.ttf      system                   Typical
Garamond  garait.ttf      system                   Typical
Century Gothic
          gothic.ttf      system                   Complete/Custom
Impact    impact.ttf      system                   Complete/Custom
Kino MT   kino.ttf        system                   Complete/Custom
Wide Latin
          latinwd.ttf     system                   Complete/Custom
Matura MT Script Capitals
          maturasc.ttf    system                   Complete/Custom
Playbill
          playbill.ttf    system                   Complete/Custom

Equation Editor 2.0
-------------------
          eqnedt32.exe    msapps\equation          Complete/Custom
          eqnedt32.hlp    msapps\equation          Complete/Custom
          eqnedt32.cnt    msapps\equation          Complete/Custom
          eqnedt32.fts    msapps\equation          Complete/Custom
          eqnedt32.gid    msapps\equation          Complete/Custom
          eqnedt32.reg    msapps\equation          Complete/Custom

Equation Font
-------------
          mtextra.ttf     system                   Complete/Custom

MS Info



-------
          msinfo32.exe    msapps\msinfo            Laptop
          msinfo32.hlp    msapps\msinfo            Laptop
          msinfo32.cnt    msapps\msinfo            Laptop
          msinf16h.exe    msapps\msinfo            Laptop
          imgwalk.dll     msapps\msinfo            Laptop

Address
-------
          wwpab.cnv       \winword                 Laptop
          schdmapi.dll    \winword                 Laptop

WordMail
--------
          email.dot       \winword                 Complete/Custom
          email1.dot      \winword                 Complete/Custom
          email2.dot      \winword                 Complete/Custom
          email3.dot      \winword                 Complete/Custom
          station.dll     \winword\wordmail        Complete/Custom
          wordmail.dll    \winword\wordmail        Complete/Custom
          mfcans32.dll    \winword\wordmail        Complete/Custom
          wordf1.cfg      \winword\wordmail        Complete/Custom
          wordf1l.ico     \winword\wordmail        Complete/Custom
          wordf1s.ico     \winword\wordmail        Complete/Custom
          mapif1.cfg      \winword\wordmail        Complete/Custom
          mapif1l.ico     \winword\wordmail        Complete/Custom
          mapif1s.ico     \winword\wordmail        Complete/Custom

Clipart
-------
          1STPLACE.WMF    \office\clipart          Complete/Custom
          ANCHOR.WMF      \office\clipart          Complete/Custom
          ARTIST.WMF      \office\clipart          Complete/Custom
          ATOMENGY.WMF    \office\clipart          Complete/Custom
          BANNER.WMF      \office\clipart          Complete/Custom
          BEARMRKT.WMF    \office\clipart          Complete/Custom
          BIRD.WMF        \office\clipart          Complete/Custom
          BOOKS.WMF       \office\clipart          Complete/Custom
          BULLMRKT.WMF    \office\clipart          Complete/Custom
          BUTTRFLY.WMF    \office\clipart          Complete/Custom
          CAT.WMF         \office\clipart          Complete/Custom
          CELTIC.WMF      \office\clipart          Complete/Custom
          CHECKMRK.WMF    \office\clipart          Complete/Custom
          CITYSCPE.WMF    \office\clipart          Complete/Custom
          COFFEE.WMF      \office\clipart          Complete/Custom
          COMPASS.WMF     \office\clipart          Complete/Custom
          COMPUTER.WMF    \office\clipart          Complete/Custom
          CONDUCTR.WMF    \office\clipart          Complete/Custom
          CONFIDEN.WMF    \office\clipart          Complete/Custom
          CONTINEN.WMF    \office\clipart          Complete/Custom
          DANCERS.WMF     \office\clipart          Complete/Custom
          DECO.WMF        \office\clipart          Complete/Custom
          DINNER1.WMF     \office\clipart          Complete/Custom
          DINNER2.WMF     \office\clipart          Complete/Custom
          DIPLOMA.WMF     \office\clipart          Complete/Custom
          DISK.WMF        \office\clipart          Complete/Custom
          DIVIDER1.WMF    \office\clipart          Complete/Custom



          DIVIDER2.WMF    \office\clipart          Complete/Custom
          DIVIDER3.WMF    \office\clipart          Complete/Custom
          DRINK.WMF       \office\clipart          Complete/Custom
          ELEPHANT.WMF    \office\clipart          Complete/Custom
          FALL.WMF        \office\clipart          Complete/Custom
          FILM.WMF        \office\clipart          Complete/Custom
          FLOURISH.WMF    \office\clipart          Complete/Custom
          FLYACE.WMF      \office\clipart          Complete/Custom
          GOLF.WMF        \office\clipart          Complete/Custom
          HANGLE.WMF      \office\clipart          Complete/Custom
          HCORNER.WMF     \office\clipart          Complete/Custom
          HDECOBOX.WMF    \office\clipart          Complete/Custom
          HEART.WMF       \office\clipart          Complete/Custom
          HMEDEVAL.WMF    \office\clipart          Complete/Custom
          HORSE.WMF       \office\clipart          Complete/Custom
          HOUSES.WMF      \office\clipart          Complete/Custom
          HPLAQUE.WMF     \office\clipart          Complete/Custom
          HPRESBOX.WMF    \office\clipart          Complete/Custom
          JAZZ.WMF        \office\clipart          Complete/Custom
          JET.WMF         \office\clipart          Complete/Custom
          LABEL1.WMF      \office\clipart          Complete/Custom
          LABEL2.WMF      \office\clipart          Complete/Custom
          LABEL3.WMF      \office\clipart          Complete/Custom
          LBLKDIAM.WMF    \office\clipart          Complete/Custom
          LDIAMOND.WMF    \office\clipart          Complete/Custom
          LEAF.WMF        \office\clipart          Complete/Custom
          LIGHTBLB.WMF    \office\clipart          Complete/Custom
          LUGGAGE.WMF     \office\clipart          Complete/Custom
          MAIL.WMF        \office\clipart          Complete/Custom
          MATH.WMF        \office\clipart          Complete/Custom
          MEDSTAFF.WMF    \office\clipart          Complete/Custom
          MOTORCRS.WMF    \office\clipart          Complete/Custom
          MOVIE.WMF       \office\clipart          Complete/Custom
          NOSMOKE.WMF     \office\clipart          Complete/Custom
          NOTES.WMF       \office\clipart          Complete/Custom
          NOUVEAU1.WMF    \office\clipart          Complete/Custom
          NOUVEAU2.WMF    \office\clipart          Complete/Custom
          NOUVFLWR.WMF    \office\clipart          Complete/Custom
          OFFICE.WMF      \office\clipart          Complete/Custom
          ORNAMNT1.WMF    \office\clipart          Complete/Custom
          ORNAMNT2.WMF    \office\clipart          Complete/Custom
          ORNAMNT3.WMF    \office\clipart          Complete/Custom
          ORNAMNT4.WMF    \office\clipart          Complete/Custom
          ORNATE.WMF      \office\clipart          Complete/Custom
          PARTY.WMF       \office\clipart          Complete/Custom
          PHARMACY.WMF    \office\clipart          Complete/Custom
          REALEST.WMF     \office\clipart          Complete/Custom
          RECYCLE.WMF     \office\clipart          Complete/Custom
          SAIL.WMF        \office\clipart          Complete/Custom
          SCALES.WMF      \office\clipart          Complete/Custom
          SERVER.WMF      \office\clipart          Complete/Custom
          SPEAKER.WMF     \office\clipart          Complete/Custom
          SPLAT.WMF       \office\clipart          Complete/Custom
          SPORTS.WMF      \office\clipart          Complete/Custom
          SPRING.WMF      \office\clipart          Complete/Custom
          SUMMER.WMF      \office\clipart          Complete/Custom
          TENNIS.WMF      \office\clipart          Complete/Custom



          THEATRE.WMF     \office\clipart          Complete/Custom
          TRAVEL.WMF      \office\clipart          Complete/Custom
          VBEVBOX.WMF     \office\clipart          Complete/Custom
          VCONTBOX.WMF    \office\clipart          Complete/Custom
          VPRISBOX.WMF    \office\clipart          Complete/Custom
          VWIND.WMF       \office\clipart          Complete/Custom
          WHEELCHR.WMF    \office\clipart          Complete/Custom
          WINE.WMF        \office\clipart          Complete/Custom
          WINTER.WMF      \office\clipart          Complete/Custom
          WOODCUT.WMF     \office\clipart          Complete/Custom
          WORD7ART.CAG    \office\clipart          Complete/Custom
                                                                 office
                                                                 only

Templates
---------
          contfax.dot     office\template\<subdir> Typical
          contltr.dot     office\template\<subdir> Typical
          contmemo.dot    office\template\<subdir> Typical
          contrepo.dot    office\template\<subdir> Typical
          elegfax.dot     office\template\<subdir> Typical
          elegltr.dot     office\template\<subdir> Typical
          elegmemo.dot    office\template\<subdir> Typical
          elegrepo.dot    office\template\<subdir> Typical
          proffax.dot     office\template\<subdir> Typical
          profltr.dot     office\template\<subdir> Typical
          profmemo.dot    office\template\<subdir> Typical
          profrepo.dot    office\template\<subdir> Typical
          brochure.dot    office\template\<subdir> Complete/Custom
          contprel.dot    office\template\<subdir> Complete/Custom
          directry.dot    office\template\<subdir> Complete/Custom
          elegprel.dot    office\template\<subdir> Complete/Custom
          manual.dot      office\template\<subdir> Complete/Custom
          newsltr.dot     office\template\<subdir> Complete/Custom
          profprel.dot    office\template\<subdir> Complete/Custom
          thesis.dot      office\template\<subdir> Complete/Custom
          contresu.dot    office\template\<subdir> Complete/Custom
          elegresu.dot    office\template\<subdir> Complete/Custom
          profresu.dot    office\template\<subdir> Complete/Custom
Macros
------
          macros7.dot     winword\macros           Complete/Custom
          convert7.dot    winword\macros           Complete/Custom
          layout7.dot     winword\macros           Complete/Custom
          tables7.dot     winword\macros           Complete/Custom
          present7.dot    winword\macros           Complete/Custom

Wizards
-------
          agenda.wiz      office\template\<subdir> Complete/Custom
          award.wiz       office\template\<subdir> Complete/Custom
          calendar.wiz    office\template\<subdir> Complete/Custom
          fax.wiz         office\template\<subdir> Typical
          pleading.wiz    office\template\<subdir> Complete/Custom
          letter.wiz      office\template\<subdir> Typical
          memo.wiz        office\template\<subdir> Typical
          newslttr.wiz    office\template\<subdir> Complete/Custom



          resume.wiz      office\template\<subdir> Complete/Custom
          cv.wiz          office\template\<subdir> Typical       Z and AA
                                                                 only
          table.wiz       office\template\<subdir> Complete/Custom
          classic1.wzs    office\template\<subdir> Complete/Custom
          classic2.wzs    office\template\<subdir> Complete/Custom
          classic3.wzs    office\template\<subdir> Complete/Custom
          classic4.wzs    office\template\<subdir> Complete/Custom
          modern1.wzs     office\template\<subdir> Complete/Custom
          modern2.wzs     office\template\<subdir> Complete/Custom
          modern3.wzs     office\template\<subdir> Complete/Custom
          modern4.wzs     office\template\<subdir> Complete/Custom

Forms
-----
          invoice.dot     office\template\<subdir> Complete/Custom
          purchord.dot    office\template\<subdir> Complete/Custom
          weektime.dot    office\template\<subdir> Complete/Custom

Letters
-------
          adpr01.dot      winword\ letters         Complete/Custom
          cred01.dot      winword\ letters         Complete/Custom
          cred05.dot      winword\ letters         Complete/Custom
          cred11.dot      winword\ letters         Complete/Custom
          cstmrc01.dot    winword\ letters         Complete/Custom
          cstmrc03.dot    winword\ letters         Complete/Custom
          cstmrr03.dot    winword\ letters         Complete/Custom
          cstmrr05.dot    winword\ letters         Complete/Custom
          emprl02.dot     winword\ letters         Complete/Custom
          emprl03.dot     winword\ letters         Complete/Custom
          mktg02.dot      winword\ letters         Complete/Custom
          mktg07.dot      winword\ letters         Complete/Custom
          other10.dot     winword\ letters         Complete/Custom
          space03.dot     winword\ letters         Complete/Custom
          suppl14.dot     winword\ letters         Complete/Custom

MSN Shortcuts
-------------
Microsoft Access 95 Forum.mcc
          msaccess.mcc    msoffice\office\msn      Laptop
Microsoft Excel 95 Forum.mcc
          msexcel.mcc     msoffice\office\msn      Laptop
Microsoft Office 95 Forum.mcc
          msoff95.mcc     msoffice\office\msn      Laptop
Microsoft Office Family Forum.mcc
          msoffice.mcc     msoffice\office\msn     Laptop
Microsoft Office Resource Kit.mcc
          msork.mcc       msoffice\office\msn      Laptop
Microsoft PowerPoint 95 Forum.mcc
          msppt.mcc       msoffice\office\msn      Laptop
Microsoft Schedule+ 95 Forum.mcc
          mssched.mcc     msoffice\office\msn      Laptop
Microsoft Word 95 Forum.mcc
          msword.mcc      msoffice\office\msn      Laptop

Converters



----------
RFT/DCA   rftdca32.cnv    msapps\textconv          Complete/Custom
          rtf_dca.txt     msapps\textconv          Complete/Custom
Text with Layout
          txtlyt32.cnv    msapps\textconv          Complete/Custom
Word for MS-DOS
          doswrd32.cnv    msapps\textconv          Complete/Custom
          rtf_pcw.txt     msapps\textconv          Complete/Custom
Word for the Mac 4.x, 5.x
          macwrd32.cnv    msapps\textconv          Complete/Custom
          rtf_mw5.txt     msapps\textconv          Complete/Custom
Word for Windows 2.x
          wnwrd232.cnv    msapps\textconv          Complete/Custom
WordPerfect 5.x
          wpft532.cnv     msapps\textconv          Typical
          rtf_wp5.txt     msapps\textconv          Typical
WordPerfect 6.x
          wpft632.cnv     msapps\textconv          Typical
WP Equation Conv (5.x and 6.x)
          wpequ532.dll    msapps\textconv          Typical
Write for Windows
          write32.cnv     msapps\textconv          Complete/Custom
Excel BIFF
          excel32.cnv     msapps\textconv          Typical
Winword 6.x
          mswrd632.cnv    msapps\textconv          Typical
Linedraw Font
          linedraw.ttf    system                   Typical
Conv. options
          mstxtcnv.ini    windows                  Typical
Lotus Notes
          _msimp32.dll    \lotusnotes?             Notes Laptop
          mscthunk.dll    system32                 Notes Laptop
Lotus 1-2-3
          lotus32.cnv     msapps\textconv          Complete/Custom
dBASE     dbase32.cnv     msapps\textconv          Complete/Custom
Works 3.0 works332.cnv    msapps\textconv          Complete/Custom
Works 95  works432.cnv    msapps\textconv          Complete/Custom
WordStar  wrdstr32.cnv    msapps\textconv          Complete/Custom

Filters
-------
Computer Graphics Metafile Import
          cgmimp32.flt    msapps\grphflt           Complete/Custom
Micrografx Designer/Draw
          drwimp32.flt    msapps\grphflt           Complete/Custom
Encapsulated PostScript
          epsimp32.flt    msapps\grphflt           Complete/Custom
GIF       msgif32.dll     msapps\grphflt           Complete/Custom
          gifimp32.flt    msapps\grphflt           Complete/Custom
JPEG      jpegim32.flt    msapps\grphflt           Complete/Custom
          msjpeg32.dll    msapps\grphflt           Complete/Custom
PCX       mspcx32.dll     msapps\grphflt           Complete/Custom
          pcximp32.flt    msapps\grphflt           Complete/Custom
TIFF      mstiff32.dll    msapps\grphflt           Typical
          tiffim32.flt    msapps\grphflt           Typical
Quick Draw to GDI  PICT



          pictim32.flt    msapps\grphflt           Typical
TGA       mstga32.dll     msapps\grphflt           Complete/Custom
          tgaimp32.flt    msapps\grphflt           Complete/Custom
WPG Import
          wpgimp32.flt    msapps\grphflt           Typical
WPG Export
          wpgexp32.flt    msapps\grphflt           Typical
Photo CD  mspcd32.dll     msapps\grphflt           Complete/Custom
          pcdimp32.flt    msapps\grphflt           Complete/Custom
          pcdlib32.dll    system32                 Complete/Custom
Corel Draw
          cdrimp32.flt    msapps\grphflt           Complete/Custom
AutoCAD DXF
          dxfimp32.flt    msapps\grphflt           Complete/Custom
HP Graphic Language
          hpglim32.flt    msapps\grphflt           Complete/Custom
PSS test files
          ms.cgm          msapps\grphflt           Complete/Custom
          ms.drw          msapps\grphflt           Complete/Custom
          ms.eps          msapps\grphflt           Complete/Custom
          ms.gif          msapps\grphflt           Complete/Custom
          ms.pct          msapps\grphflt           Typical
          ms.pcx          msapps\grphflt           Complete/Custom
          ms.tif          msapps\grphflt           Typical
          ms.wpg          msapps\grphflt           Typical
KBCategory:
KBSubcategory:
Additional reference words: winword word7 word95



Word Cannot Find the Word Forms File MSWDS_EN.LEX
Article ID: Q132047
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

When you use the Find command on the Edit menu and select the Find All Word
Forms option, you may receive the error message:

   Word cannot find the Word Forms File MSWDS_EN.LEX for English(US).

CAUSE
=====

When you perform a Typical setup of Word or Office, the file MSWDS_EN.LEX
is not installed. This file is required for the Find All Word Forms feature
to work.

You may also receive this error message if the file MSWDS_EN.LEX is damaged
or missing.

RESOLUTION
==========

Method 1: Run Setup again to install Find All Word Forms. (In Office Setup,
          this option is located under the options for Microsoft Word.)
          When the installation options appear, do the following:

          a. Choose the Custom option.
          b. Click Proofing Tools.
          c. Click the Change button.
          d. Select the Find All Word Forms check box.
          e. Continue with Setup.

Method 2: You can also install Find All Word Forms through Maintenance Mode
          setup. Click the Add/Remove button and then choose the options in
          Method 1.

KBCategory: kbsetup kbusage
KBSubcategory: kbproof
Additional reference words: word95 7.00 word forms editfind edit find
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Word 95: WordBasic Err=582 "Unable to Load Specified Library"
Article ID: Q132214
-------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
-------------------------------------------------------------------------

SYMPTOMS
========

When you run a macro or wizard designed for Word 2.0 or 6.0 in Word for
Windows 95, or you open a file or save a file, or when you start Word, you
may receive the following error message:

     WordBasic Err= 582, Unable to load specified library

or

     WordBasic Error = : Invalid library

Note: This problem does not occur in earlier versions of Word running
under Windows 95.

CAUSE
=====

Macros, wizards, templates or global Add-ins that worked in earlier
versions of Word may not run at all in Word for Windows 95. This happens
when a macro makes a call to 16-bit DLLs (dynamic link libraries) or the
Add-in is designed to run on 16-bit Windows 3.x. Word 7.0 is a 32-bit
application and cannot communicate with 16-bit DLLs.

Word version 2.0 and Word version 6.0 will run under Windows 95, and these
programs can successfully work with 16-bit DLLs.

WORKAROUND
==========

If you are using a wizard or macro supplied with Word 6.0, you may be able
to use a similar wizard or macro that comes with Word 7.0. The following
are similar:

   Word 6.0 Wizard Name     Word 7.0 Wizard Name
   --------------------     --------------------

   Fax.wiz                  Fax Wizard.wiz
                            Professional Fax.dot
                            Contemporary Fax.dot
   Letter.wiz               Letter Wizard.wiz
                            Professional Letter.dot
                            Contemporary Letter.dot
   Memo.wiz                 Memo Wizard.wiz
                            Contemporary Memo.dot
                            Elegant Memo.dot
                            Professional Memo.dot



   Word 6.0 Macro Name      Word 7.0 Macro Name
   -------------------      -------------------

   PrnSel2File              SaveSelectionToTextFile in Macros7.dot
   FontSampleGenerator      (same name) in Macros7.dot
   PrintableCharacters      (same name) in Layout7.dot

If you are using a custom macro, you will need to rewrite it to use the 32-
bit API function equivalents instead of the 16-bit API calls.

For additional information on determining 32-bit equivalents, please see
the following article in the Microsoft Knowledge Base:

   ARTICLE-ID: Q120767
   TITLE     : Porting WordBasic Macros to Word for Windows NT

TROUBLESHOOTING
===============

If you receive this error message when starting Word or opening a new file,
the following instructions may help you locate the source of the problem:

1. Look for Auto macros:

   a. On the Tools menu, click Macros.

   b. In the Macros Available In list, select All Active Templates.

   c. Look for any macros that start with the word "Auto," such as AutoNew,
      AutoOpen, AutoExec, and AutoClose.

   d. Click the Organizer button.

   e. Click the Macros tab.

   f. Highlight any Auto macro, and click the Rename button. Give the
      macro a new name by placing another letter at the beginning of the
      macro name. The macro will still be available, but it won't load
      automatically.

   g. Repeat the procedure that produced the problem. If the error message
      persists, continue with steps 2 and 3. If the message no longer
      appears, either rewrite the macro or contact the person who wrote it
      to get an updated macro.

2. Look in the Startup folder for global templates and add-ins:

   a. Using Explorer, look in Word's Startup folder.

   b. Temporarily move the items from the Startup folder to the Desktop.

   c. Restart Word.

   d. If the error message persists, continue with step 3. If the message
      no longer appears, contact the creator of the add-in for an updated
      file.



3. Look in File Templates for other global templates and add-ins:

   a. On the File menu, click Templates.

   b. In the "Global Templates and Add-ins" list, clear (remove the X from)
      any item that is selected.

   c. Restart Word.

MORE INFORMATION
================

For more information, open Word Help and click the Find tab. Search for
"WordBasic Error 582."

The following wizards supplied with Word 6.0 will generate the error
message:

   Wizard Name              Filename
   -----------              --------

   Agenda Wizard            Agenda.wiz
   Award Wizard             Award.wiz
   Calendar Wizard          Calendar.wiz
   Fax Wizard               Fax.wiz
   Letter Wizard            Letter.wiz
   Memo Wizard              Memo.wiz
   Newsletter Wizard        Newslttr.wiz
   Pleading Wizard          Pleading.wiz
   Resume Wizard            Resume.wiz
   Table Wizard             Table.wiz

The following macros supplied with Word 6.0 will generate the error
message:

   Macro Name               Template Name
   ----------               -------------

   BatchConversion          Convert.dot
   EditConversionOptions    Convert.dot
   PrintableCharacters      Layout.dot
   FontSampleGenerator      Macro60.dot
   MindBender               Macro60.dot
   PrnSel2File              Macro60.dot
   AccessExporter           Tables.dot

In addition, if you are using a custom macro that contains any of the
following commands, you will receive the error message described above:

   FindWindow
   CreateWindow
   GetActiveWindow
   GetModuleHandle
   SendMessage
   ShellExecute



The following list of common Add-ins have produced the error message
described above:

   Alki Sofware's MasterWord
   Woody Leonhard's "WOPR" package
   Bookshelf 94 integration
   Internet Assistant 1.0
   Norton's File Assistant

Contact the Add-in vendor or macro author for an update.

The third-party products included here are manufactured by vendors
independent of Microsoft; we make no warranty, implied or otherwise,
regarding these products' performance or reliability.

KBCategory: kbinterop
KBSubcategory: kbmacro
Additional reference words: word95 7.00 template MAPI ODBC CAPI
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FileSendMail Command and MsgBox May Cause MAPI Error
Article ID: Q132912
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

If you use a message box statement (MsgBox) with the FileSendMail command
in Word, you may receive the following error message:

   Microsoft Exchange Error:  MAPI Error:  Microsoft Word - 0 - (80010001)

CAUSE
=====

The error is caused by a focus conflict between the two commands.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

MORE INFORMATION
================

Details of this MAPI error will show that Word caused an invalid page
fault. As long as the error MAPI error message is on the screen, WordMail
is tied up. Therefore, if you start Exchange, you will receive a "WordMail
initialization failure" error in Exchange.

KBCategory: kbother kbmacro buglist7.00
KBSubcategory:
Additional reference words: word95 7.00 wordmail MAPI error message box
word7 messagebox mail exchange wordbasic



Word 95: "No Proofing" Message in Document with Fields
Article ID: Q132918
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

When you check the spelling of a document containing fields, this message
appears when the spell checking is done:

   The spelling check is complete. Text formatted with (no proofing) was
   skipped.

Or, when you type a new field and update it (by pressing CTRL+F9, typing
the field name, and updating the field), the entire field is formatted as
"(no proofing)."

CAUSE
=====

Word automatically formats fields with the "(no proofing)" language
property. The message appears to let you know that Word did not check the
spelling of some text in the document.

STATUS
======

This behavior is by design; field names are not recognized by the spelling
checker. Formatting them as "(no proofing)" prevents the spelling checker
from stopping to spell check them, since they're already spelled correctly.

MORE INFORMATION
================

The following fields are marked "(no proofing)":

   =                        NEXT
   ADDIN                    NEXTIF
   AUTHOR                   NUMCHARS
   AUTONUM                  NUMPAGES
   AUTONUMLGL               NUMWORDS
   AUTONUMOUT               PAGE
   BARCODE                  PAGEREF
   COMPARE                  PRINT
   CREATEDATE               PRINTDATE
   DATA                     PRIVATE
   DATABASE                 RD
   DATE                     REVNUM
   DDE                      SAVEDATE
   DDEAUTO                  SECTIONPAGES
   EDITTIME                 SEQ



   EQ                       SET
   FILENAME                 SKIPIF
   FILESIZE                 STYLEREF
   FORMCHECKBOX             SYMBOL
   FORMTEXT                 TA
   FTNREF                   TC
   IF                       TEMPLATE
   INCLUDEPICTURE           TIME
   INDEX                    TOA
   LASTSAVEDBY              TOC
   MACROBUTTON              USERADDRESS
   MERGEREC                 USERINITIALS
   MERGESEQ                 USERNAME

The following fields are marked with the language of the Word program they
were created with:

ADVANCE                  INCLUDETEXT
ASK                      INFO
AUTOTEXT                 KEYWORDS
COMMENTS                 LINK
DOCPROPERTY              MERGEFIELD
DOCVARIABLE              NOTEREF
EMBED                    QUOTE
FILLIN                   REF
FORMDROPDOWN             SECTION
GLOSSARY                 SUBJECT
GOTOBUTTON               SUBSCRIBER
IMPORT                   TITLE
INCLUDE                  XE

KBCategory:  kbusage
KBSubcategory: kbproof
Additional reference words: word95 7.00 form forms word7



How to Prevent Highlighting from Printing
Article ID: Q133043
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SUMMARY
=======

This article describes how to prevent highlighting from printing. The
highlighted text will print, but the highlighting itself will not.

MORE INFORMATION
================

To prevent highlighting from printing, do the following:

1. On the Tools menu, click Options.

2. Click the View tab.

3. Clear the Highlight check box.

Highlighting will not appear in the document, nor will it print. The
formatting information is still in the document and will be visible if you
reselect the Highlight box in step 3.

For more information, click Answer Wizard on the Help menu, and search
on the words "highlighting" and "printing".

KBCategory: kbusage
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Can't Include Highlighting as Part of Style
Article ID: Q133044
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SUMMARY
=======

Highlighting information cannot be included as part of style formatting. It
can't be recorded as part of a style, nor is it available when you create a
style in the Style dialog box.

MORE INFORMATION
================

To apply highlighting as a part of a style, do the following:

1. Define a style (without highlighting).
2. Record a macro in which you apply that style to a paragraph.
3. Click the Highlight button.
4. Stop recording the macro.
5. Assign the macro to a toolbar button or keystroke.

KBCategory: kbui
KBSubcategory: kbformat
Additional reference words: word95 7.00 highlighting word7



Word 95: "Cannot Retrieve Properties for..."
Article ID: Q133195
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

When you try to view the properties of a document that has a preview
picture, and you are looking at files in Preview view in the File Open
dialog box, you receive the error message

   Cannot retrieve properties for '<filename>'

where "<filename>" is the name of the document whose properties you are
trying to view.

CAUSE
=====

This happens because Word actually opens the file in order to display the
preview.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Since Word does not display the preview immediately, you can attempt to
view the properties before Word opens the file by doing the following:

1. Click another filename.

2. Click the file you want to examine.

3. Quickly click the right mouse button and choose Properties, or quickly
   press ALT+ENTER.

The properties now display.

MORE INFORMATION
================

You can save a preview picture with a document by opening the document,
clicking Properties on the File menu, and selecting the Save Preview
Picture option (at the bottom of the dialog box). Selecting this option
saves a snapshot of the first page of the document.



To view this snapshot, click Open on the File menu, and select the
Preview button at the top of the Open dialog box.

KBCategory: kbother buglist7.00
KBSubcategory:
Additional reference words: word95 7.00 thumbnail word7



Word 95: Can't Rename or Delete File in File Open
Article ID: Q133196
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

When you try to rename or delete a file in Word's File Open dialog box and
you are viewing files in Preview mode, you receive the following error
message:

   Cannot rename [or delete] '<file name>'. Access is denied. Make sure
   the disk is not full or write-protected and that the file is not
   currently in use.

CAUSE
=====

This occurs when the file you are trying to rename or delete has not been
Preview Picture saved. Word has actually opened the file so that you can
scroll through it in the File Open dialog box.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. We are researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Change the view from Preview to any other view (such as List, Details, or
Properties) by clicking the appropriate button in the File Open dialog box
before attempting to rename or delete a file.

MORE INFORMATION
================

Preview Picture allows a snapshot of the first page of the document to
appear in the File Open dialog box.

KBCategory: kbother buglist7.00
KBSubcategory:
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Unable to Type in Message Area in WordMail
Article ID: Q133197
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

If you use the WordMail option in Microsoft Exchange and you compose a new
mail message, the keyboard does not respond in the message area.

CAUSE
=====

This occurs when the File New dialog box is open in Microsoft Word.
WordMail is using Microsoft Word to create the mail message, and the File
New dialog box prevents typing the new message.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

RESOLUTION
==========

Switch to Microsoft Word and cancel the File New dialog box.

MORE INFORMATION
================

When you use WordMail as your mail editor in Microsoft Exchange, Exchange
uses the existing session of Microsoft Word, or creates one if Word is not
running. If a dialog box such as File New is open, it prevents the session
from continuing, thus rendering WordMail unable to continue. The To:,
From:, CC's: and Subject: areas of the new message are components of
Exchange, while the message area is a component of WordMail.

Note: This error does not occur if the WordMail session is started before
Word is started; in this case, WordMail and Word each run in a separate
session.

KBCategory: kbinterop buglist7.00
KBSubcategory:
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DefaultDir$() and GetDirectory$() Return Lowercase Path
Article ID: Q133788
--------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------

SYMPTOMS
========

The DefaultDir$() and GetDirectory$() functions in WordBasic both return a
path in all lowercase letters instead of mixed-case letters, which is
supported by Windows 95 and Windows NT.

CAUSE
=====

This is a limitation of the WordBasic commands.

WORKAROUND
==========

You can convert the path into all uppercase characters by using the
UCASE$() function. For example, the following function returns
C:\MSOFFICE\TEMPLATES:

   MsgBox UCase$(DefaultDir$(1))

There is no direct way to return the mixed-case form of the paths.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95 version
7.0. We are researching this problem and will post new information here in
the Microsoft Knowledge Base as it becomes available.

KBCategory: kbother kbmacro buglist7.00
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Word 7.0 Installation Types And Space Requirements
Article ID: Q133796
---------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
---------------------------------------------------------------------------

SUMMARY
=======

This article summarizes the Word components that Setup installs for each
option: Compact, Typical, Complete, and Workstation. Summaries are given
for both standalone Word and for Office.

Disk Space Requirements for Word
================================

Requirements are rounded up to the nearest megabyte.

Microsoft Word 95
     Compact Installation - 6 MB
     Typical Installation - 16 MB
     Complete Installation - 33 MB
     Workstation Installation - Varies

Microsoft Office 95 - Word Related Components Only

     Compact Installation - 9 MB
     Typical Installation - 19 MB
     Complete Installation - 36 MB
     Workstation Installation - Varies

     Note: Compact and Typical installs of Office include MS Graph 5.0, and
TIF
     and BMP Graphics filters. This is why there is an additional disk
space
     requirement.

Microsoft Word for Windows 95
=============================

Compact
-------

     Microsoft Word Program Files

     Proofing Tools (partial)
      Spelling

     Converters and Filters (partial)
      Graphics Filter
         Macintosh PICT image

     Word Tools (partial)



      MSInfo
      AddressBook

Typical
-------

     Microsoft Word Program Files

     Proofing Tools (partial)
          Spelling
          Hyphenation
          Thesaurus
          NOTE:  Grammar checker is NOT installed in a Typical
installation.

     Converters and Filters (partial)
          Converters
               Microsoft Excel Converter
               Word 6.0/7.0 for Windows/Macintosh Converter
               WordPerfect 6.x Converter
               WordPerfect 5.x Converter

          Graphics Filter
               WordPerfect Graphics Import
               WordPerfect Graphics Export
               Macintosh PICT image
               JPEG

     Online Help
          Online Help for Microsoft Word

     Wizards, Templates, and Letters
          Faxes
          Letters
          Memos
          Reports

     Word Tools (partial)
          MSInfo
          FindFast
          Microsoft True Type fonts
          AddressBook

Complete
--------

     Installs all components

Workstation
-----------

     Varies based on Setup.stf script or customized setup script

Microsoft Office for Windows 95
===============================



Compact
-------

     Microsoft Word
          Microsoft Word Program Files
          Address Book

     Office Tools
          Spell Checker
          MS Graph 5.0
          MSInfo

     Converters, Filters, and Data Access
          Graphics Filters
               TIF
               Windows Bitmap
               Macintosh PICT image

Typical
-------

     Microsoft Word
          Microsoft Word Program Files

          Online Help
               Online Help for Microsoft Word

          Wizards, Templates, and Letters
               Faxes
               Letters
               Memos
               Reports

          Proofing Tools
               Hyphenation
               Thesaurus

          Address Book

     Office Tools
          MS Graph 5.0
          MS Graph 5.0 Help
          FindFast
          Clipart Gallery
          Clipart
               Word Clipart
          Microsoft True Type Fonts
          Animation Effects Sound

     Converters, Filters, and Data Access
          Converters
               Microsoft Excel Converter
               Word 6.0/7.0 for Windows/Macintosh Converter
               WordPerfect 6.x Converter
               WordPerfect 5.x Converter



          Graphic Filters
               TIF
               Windows Bitmap
               WordPerfect Graphics Import
               WordPerfect Graphics Export
               Macintosh PICT image
               Windows Metafile
               JPEG

Complete
--------

     Installs all components

Workstation
-----------

     Varies based on Off95std.stf or customized setup script

KBCategory:
KBSubcategory:
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Using Highlight Tool Causes Option To Be Turned On
Article ID: Q133840
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

Selecting the Highlight toolbar button enables any previous document
highlighting to show.

CAUSE
=====

When the Highlight toolbar button is pressed, the Highlight option is
selected on the View menu automatically by Word. Thus, any previous
document highlighting will become visible and may give the appearance that
the Highlight tool is not functioning correctly.

MORE INFORMATION
================

Microsoft Word 7.0 for Windows 95 provides a new text Highlighting feature.
This feature is a view option from the Tools, Options menu. If this option
is selected, any highlighting that has been applied to text in the document
will become visible.

In order for Word 7.0 to display (and print) any text highlighting, the
View Highlight option must be selected. If this option is not selected,
then the text highlighting will not be displayed (or printed). Once this
option has been selected, the option must be turned off manually through
the menu selections.

To Turn Off Highlighting:
-------------------------

1. Select Options from the Tools menu.
2. Select the View tab. Clear the Highlight checkbox under Show.

KBCategory:
KBSubcategory:
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Word Prompts to Save Changes Unnecessarily When Closing File
Article ID: Q133860
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you close a document after saving it, Word may prompt you to save
changes even though there are apparently no changes to be saved.

CAUSE
=====

This behavior is by design and occurs when the Word Automatic Spell
Checking feature is enabled. When you have the Automatic Spell Checking
option selected, Word may add information to the document after you save it
that causes Word to prompt to save changes. Automatic Spell Checking makes
changes to the document by adding information about each word being
correctly or incorrectly spelled. When spelling data is changed after a
save, Word asks if you want to save changes to ensure that the valuable
spelling data is saved.

MORE INFORMATION
================

To reproduce this behavior, change some text in your document and then
quickly save the document while the small icon in the status bar is moving.
After you save, Word adds new spelling data to the document, and that new
data causes Word to ask if you want to save changes when you close the
file.

To turn off automatic spell checking, do the following:

1. On the Tools menu, click Options.
2. Click the Spelling tab.
3. Clear the Automatic Spell Checking check box.

KBCategory: kbother
KBSubcategory: kbproof
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Spelling Shortcut Menu Does Not Pop Up with Right Mouse Click
Article ID: Q133872
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

The spell checking shortcut menu does not appear when you use the right
mouse button to click the paragraph mark, manual line break, or any
punctuation mark following a misspelled word. Instead, the editing shortcut
menu appears.

CAUSE
=====

Neither a paragraph mark, a manual line break character, nor any
punctuation mark following a misspelled word is considered to be part of
the word. However, spaces to the right of a word are considered to be part
of that word.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95 version
7.0. Microsoft is researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

With the right mouse button, click the misspelled word itself instead of
the paragraph mark, manual line break, or punctuation mark following that
word.

KBCategory: kbother buglist7.00
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TrueType Text Bleeds Through Drawing Objects When Printed
Article ID: Q133878
-------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
-------------------------------------------------------------------------

SYMPTOMS
========

If a shaded drawing object is superimposed over text formatted with
TrueType fonts, the text may "bleed through" the drawing object when
printed to a Hewlett-Packard (HP) LaserJet 4 PCL printer if the "TrueType
as Graphics" or "Download TrueType as Bitmap Soft Fonts" printing option is
turned on.

STATUS
======

Microsoft is researching this problem and will post new information here in
the Microsoft Knowledge Base as it becomes available.

WORKAROUNDS
===========

Method 1: Turn off the "TrueType as Graphics" or "Download TrueType as
          Bitmap Soft Fonts" printing options.

Method 2: Use an HP LaserJet III printer driver.

Method 3: Format the document using a font other than Times New Roman,
          Courier New, Symbol, or Arial.

MORE INFORMATION
================

The HP LaserJet has some standard TrueType fonts build into the printer.
The problem occurs only when you use one of these built-in TrueType fonts.
These fonts include Times New Roman, Courier New, Symbol, and Arial.

Because the HP LaserJet III does not have built-in TrueType fonts, this
problem does not occur with this printer driver.

This problem does not occur when you run Word with Windows NT.

KBCategory: kbprint
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Text Formatting Lost When Sending Text From Word To WordMail
Article ID: Q133880
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

If you uncheck the "Mail as Attachment" option from the Tool/Options menu
under the General Tab, then text formatting will be lost when you send it
to a mail message even if you are using WordMail.

CAUSE
=====

Word offers two choices to the user: to send as attachment or to send as
plain text. If "Mail as Attachment" is not checked, then any text sent to
mail is sent in a text only format.

STATUS
======

The feature operates this way by design.

MORE INFORMATION
================

This feature is designed to allow users to use Word to send messages to
generic mail systems in a format that any system can read. Therefore it
strips any formatting that may be misread by other mail systems, and sends
only text.

KBCategory:
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Word Opens Master Document as Read-Only
Article ID: Q133910
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

After you save a master document, close it, and reopen it, Word may open
the document as read-only.

CAUSE
=====

As in Word 6.0, Word 7.0 opens a Master Document as read-only if you are
not the author. To determine who the author is, Word looks at the Author
field on the Summary tab of the File Properties dialog box and compares the
name to the Name field on the User Info tab in the Tools Options dialog
box. If they don't match, Word opens the file as read-only.

However, unlike Word 6.0, Word 7.0 saves the Author name from the Tools
Options User Info tab when the Master document is created (File New)
instead of when the document is saved for the first time. So it is possible
to start a new document, change the name in the Name field of the User Info
tab in Tools Options, add subdocuments, save the master document, and then
have the master document reopen as read-only because, at this point, the
Author name will not match the User name.

WORKAROUND
==========

To open the master document so that you can make changes to the file,
change the Name field on the User Info tab in Tools Options so it matches
the Author field in the document properties of the main document. When you
close and then reopen the master document, Word opens it as read-write.

To prevent the creation of a master document with an incorrect Author name,
verify that the Name field on the User Info tab in Tools Options is correct
before creating a new document, or verify the Author name on the Summary
tab in File Properties is correct before saving master documents for the
first time.

KBCategory:  kbusage
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Automatic Spell Checking Flags Words Incorrectly
Article ID: Q133984
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

 - Automatic Spell Checking may not flag words as misspelled or as repeated
   words if they are formatted as hidden text.

   -or-

 - Automatic Spell Checking (the red, wavy underline) may flash off and on
   as you type.

CAUSE
=====

These symptoms appear when you work with text formatted as hidden and View
Hidden Text is turned off on the View tab of Tools Options.

In the first case, Word will not spell check any hidden text you typed
while View Hidden Text was turned off. Once you turn View Hidden Text on,
Word will automatically check only the word immediately to the left of the
insertion point. Thus, Word does not check any other misspelled or repeated
words that you typed.

In the second case, if the insertion point precedes or follows hidden text,
then as you type nonhidden text, you may see the red, wavy lines flash on
and off.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

These problems do not occur if you have View Hidden Text turned on while
working with a document that contains hidden text. To turn this option on:

1. On the Tools menu, click Options.
2. Click the View tab.
3. Under Nonprinting Characters, select the Hidden Text check box.

KBCategory: kbusage buglist7.00
KBSubcategory: kbproof
Additional reference words: word95 7.00 word7



Field Highlight Extends Beyond Selected Field
Article ID: Q134039
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

In Microsoft Word for Windows 95, Field shading may extend beyond the end
of the field to the end of the current line.

CAUSE
=====

This problem occurs when all of the following conditions are true:

 - The Field Codes check box is selected (it contains a check mark)

   -and-

 - Field Shading is set to When Selected

   -and-

 - The insertion point is on the field

This also happens when these conditions are true:

 - The Field Codes check box is selected (it contains a check mark)

   -and-

 - Field Shading is set to Always

Note that if you clear the Field Codes check box, if you place the
insertion point on the result of a field, Word will highlight only the
results of the field and not text that may follow the field.

WORKAROUND
==========

To avoid this display problem, either clear the Field Codes check box or
set Field shading to Never. To locate these options, click Options on the
Tools menu, and then click the View tab.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95 version
7.0. Microsoft is researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

KBCategory: kbusage
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Pen Windows Support Not Available with Word for Windows 95
Article ID: Q134043
-------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
-------------------------------------------------------------------------

SYMPTOMS
========

Pen Windows does not work with Word for Windows 95.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

KBCategory: kbinterop buglist7.00
KBSubcategory:
Additional reference words: word95 7.00 word7



WordBasic Commands That Are Invalid in WordMail
Article ID: Q134055
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
========

This article lists WordBasic commands that are known to be invalid in
WordMail. This list is generated using CommandValid. There may be
additional invalid WordBasic commands that are not listed here.

MORE INFORMATION
================

Micrososft Word is an Multiple Document Interface (MDI) application, while
its document object, WordMail, is not. This causes "CommandValid" to show
as available some commands that may not work in WordMail. If you encounter
one of these commands, the error message will read:

   The <command name> command is not available because this document is
   in another application.

Below is a list of commands that are known to be invalid in WordMail:

AutomaticChange
ChooseButtonImage
CopyButtonImage
CountWindows
CreateSubdocument
DisableAutoMacros
DocClose
DocMaximize
DocMinimize
DocMove
DocRestore
DocSize
DocSplit
DocumentPropertyExists
DocumentPropertyName
DocumentPropertyType
DocumentStatistics
EditButtonImage
FilePost
FilePrintPreview
FilePrintPreviewFullScreen
FilePrintPreviewPages
FileProperties
FileRoutingSlip
FileSaveAll
FileSendMail
FileSummaryInfo
FileTemplates



FindFile
FormatAddrFonts
GetDocumentProperty
HelpExamplesandDemos
HelpMSN
HelpQuickPreview
HelpWordPerfectHelp
HelpWordPerfectHelpOptions
InsertDatabase
InsertMergefield
InsertSubdocument
IsMacro
Keymacro
Lockdocument
Magnifier
MailMerge
MailMergeAskToConvertChevrons
MailMergeCheck
MailMergeConvertChevrons
MailMergeCreateDataSource
MailMergeCreateHeaderSource
MailMergeDataForm
Mailmergedatasource
MailMergeEditDataSource
MailMergeEditHeaderSource
MailMergeEditMainDocument
MailMergeFindRecord
MailMergeFirstRecord
mailmergefoundrecord
MailMergeGoToRecord
MailMergeHelper
MailMergeInsertAsk
MailMergeInsertFillIn
MailMergeInsertIf
MailMergeInsertMergeRec
MailMergeInsertMergeSeq
MailMergeInsertNext
MailMergeInsertNextIf
MailMergeInsertSet
MailMergeInsertSkipIf
MailMergeLastRecord
Mailmergemaindocumenttype
MailMergeNextRecord
MailMergeOpenDataSource
MailMergeOpenHeaderSource
MailMergePrevRecord
MailMergeQueryOptions
MailMergeReset
mailmergestate
MailMergeToDoc
MailMergeToPrinter
MailMergeViewData
MenuMode
MergeSubdocument
NextWindow
OpenSubdocument
PrevWindow



RemoveSubdocument
ResetButtonImage
ResetNoteSepOrNotice
SaveTemplate
ShowvarsSplitSubdocument
ToolbarButtonName
ToolbarName
ToolbarState
ToolsCreateEnvelope
ToolsCreateLabels
ToolsCustomize
ToolsCustomizeKeyboard
ToolsCustomizeMenuBar
ToolsCustomizeMenus
ViewMasterDocument
ViewToggleMasterDocument
WindowList
WindowNewWindow

KBCategory: kbmacro
KBSubcategory:
Additional reference words: word95 7.00 wordbasic commands valid error
word7 unavailable



WinFax Pro Buttons and Menus Not Available in Word
Article ID: Q134062
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

WinFax Pro buttons and menus are not available in Word for Windows 95,
version 7.0. WinFax Pro may also cause error messages printing to the fax
driver from Word. One common error message is:

   Select Paper Size between 0-22 inches.

CAUSE
=====

WinFax Pro looks for a Template (singular) folder for its information. This
path is hard-coded in WinFax Pro by Delrina. In Word for Windows 95, the
directory structure has changed to MsOffice\Templates (plural). Therefore,
when WinFax looks for the Template folder, it cannot find one and cannot
add the macros necessary to provide its functionality in Word.

STATUS
======

This issue is under review by Delrina and a correction will be considered
for inclusion in a future release of WinFax Pro.

WORKAROUND
==========

1. Create a subfolder in the Word program folder and name it Template.

2. Move your Normal.dot template to this new folder.

3. Reinstall WinFax Pro.

4. Copy the Normal.dot file from the Winword\Template folder back to its
   correct location in the MsOffice\Templates folder.

MORE INFORMATION
================

The third-party products discussed here are manufactured by vendors
independent of Microsoft; we make no warranty, implied or otherwise,
regarding these products' performance or reliability.

For more information, contact Delrina Customer Service:

Delrina Corporation
6830 Via Del Oro
Suite 240



San Jose, CA 95119-1353
(408) 363-2345

KBCategory: kb3rdparty
KBSubcategory:
Additional reference words: word95 7.00 macros buttons menus print paper
word7 size



Word 95: Word 6 Startup Directory Contents Not Copied to Word
Article ID: Q134113
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you install Word 7.0 on a computer where Word 6.0 is already
installed, the contents of the Word 6.0 Startup folder is not copied to the
new Word 7.0 Startup folder.

CAUSE
=====

This is by design. The Startup folder typically contains Word add-ins and
templates that contain macros that make 16-bit API calls. These 16-bit API
calls or 16-bit Word add-ins will generate error messages if you run them
in Windows 95. By not copying the contents of the Startup folder to the
Word 7.0 Startup folder, you are less likely to encounter error messages
when you start Word.

WORKAROUND
==========

If you have templates in the Word 6.0 Startup folder that do not contain
macros that make 16-bit API calls, you can copy or move these templates to
the Word 7.0 Startup folder. Under no circumstances should a Word 6.0 add-
in (a 16-bit WLL) be copied to the Word 7.0 Startup folder: it will not
work with Word 7.0. Rather than use a 16-bit WLLs or add-in, you must
obtain a 32-bit update from the add-in author.

KBCategory: kbusage
KBSubcategory:

Additional reference words: word95 7.00 582 library unable load specified
word7



Closing WinMail Modal Dialog Box Produces Error
Article ID: Q134120
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

If you cancel more than one WordMail message while a modal dialog box is
open in Word, Word produces the following error message when you close the
modal dialog box:

   There is insufficient memory. Word cannot display the requested font.

In addition, the next time you open a WordMail message, Word produces a
general protection fault (GP fault) or an invalid page fault.

Note: A modal dialog box is any dialog box that requires focus and does not
relinquish focus until you click OK or Cancel. Examples include File New,
File Open, File Save, and Insert Object. Most dialog boxes in Word are
modal.

CAUSE
=====

The wrong windows are closed when the WordMail messages are canceled
because the activate is not being changed properly.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUNDS
===========

Method 1: Open only one WordMail message at a time.

Method 2: Close the modal dialog box before canceling the WordMail
messages.

KBCategory: kbinterop kbui kbnetwork buglist7.00
KBSubcategory:
Additional reference words: word95 7.00 WordMail dialog GP fault gpf
invalid page fault hang hung crash crashed locks locked frozen freezes
word7 crashing quit quits stopped crashes bomb frozen



The Purpose of the Select Method Check Box
Article ID: Q134207
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

When you insert a database in Word for Windows 95, one of the options in
the File Open dialog box is Select Method. When you choose this option,
Select Method brings up a dialog box with the available converters and
allows you to select whether you want Word to use a converter, DDE, or ODBC
when importing data. If this option is not selected, Word examines the data
file's format and chooses the appropriate method on its own.

This option has the same function as the Confirm Conversions On Open option
in the Tools Options dialog box, but it is independent of that setting.

MORE INFORMATION
================

To locate this option, click Database on the Insert menu, and then click
Get Data. The Select Method option is located along the right edge of the
dialog box.

KBCategory: kbinterop
KBSubcategory:
Additional reference words: 7.00 word95 word7



Word 95: Contents of WDREADME (WDREADME.TXT)
Article ID: Q134208
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

This article contains the contents of the Wdreadme file located in the
Winword folder. If you are viewing filenames with extensions, the file name
will appear as Wdreadme.txt. This file is included in the Word for Windows
95 standalone package and the Office for Windows 95 package.

MORE INFORMATION
================

(To view most effectively in Notepad, turn on Word Wrap, on the Edit menu.)

MICROSOFT WORD FOR WINDOWS 95
Supplemental Information

----------------------------------------------------------------
CONTENTS
Setup Information
Installing an UPGRADE version of Word for Windows 95
Setup on Windows NT 3.51 (or later)
Using Help on Windows NT 3.51 Without Service Pack 1
Removing Earlier Word Version's Help Files From Path statement
Using Disks with Distribution Media Format (DMF)
Printing EPS files in Windows 95 or Windows NT
Equation Editor
Lotus cc:Mail or Lotus Notes
Field Codes: Bookmark and REF Fields
Using Word 6.0 or Word 2.0 Templates with Word for Windows 95
Word for Windows 95 Default Setup Options
Using Foreign Language Proofing Tools with Word for Windows 95
Using Microsoft Bookshelf 1994 with Word for Windows 95
WordBasic Errors with Word 6.0 Add-ins and Macros
WordMail Information
ODBC Not Included with Word for Windows 95
Windows 95 for Pen Computing
Updates to Getting Results with Microsoft Word for Windows 95
-----------------------------------------------------------------

[Setup Information]

When you install Word, the Setup program will not be installed on your hard
disk drive.

[Installing an UPGRADE version of Word for Windows 95]

An installed copy, or the first installation disk, for one of the following
Word Processing packages or office suites is required in order to install



the Upgrade version of Word for Windows 95.

Ami Pro 1.0, 1.01, 1.1, 1.1B, 1.2, 2.0, 3.0, 3.01 for Win
Display Write for DOS 1.0, 1.1, 2.0, 2.1
First Choice for DOS 1.01
Legacy for Windows 1.0
Lotus Manusc for DOS 1.0
Lotus Manusc for DOS 2.1
Mass 11  6C
Multimate 1.0, 4.0
Multimate for DOS 1.0, 3.3, 3.6, 4.0
Prof Write+ for Windows 1.0
ProfWrite for DOS 1.0
Q&A for DOS 1.0
Samna Word for DOS IV
Sprint for Windows 1.01
Volks W III for DOS 1.0
Word for Dos 2.0, 3.0, 4.0, 5.0, 5.5, 6.0
Word for Windows 1.0, 1.1, 2.0c, 6.0, 6.0c
WordPerfect 5.1, 6.0, 6.0A Win
WordPerfect* 4.0, 4.1, 4.2, 5.1, 5.2 DOS
Wordstar 1.0, 1.5, 2.0 for Windows
Wordstar 2000 for DOS 3.0, 3.5, 6.0
Wordstar for DOS 1.0, 1.5, 5.5, 6.0, 7.0, 7.0 Upgrade
Wordstar Pro for DOS 1.0, 4.0
XyWriteIII+ for DOS 3.06, 3.52, 3.56
Word Perfect 6.1
Ami Pro 3.1

Smart Suite
Perfect Office
Borland Office
Microsoft Works (all versions)
Microsoft Office (all versions)

[Setup on Windows NT 3.51 (or later)]

If you are installing on Windows NT 3.51, you will need to obtain an
updated version of an NT 3.51 system file named WINSRV.DLL. This file will
be contained in Service Pack 1 for NT 3.51. The Service Pack will also
address some issues with the Help on Windows NT 3.51 and contain other
enhancements. Once the Service Pack is available, NT 3.51 users will be
able to access it the following way: This file can be obtained by

For CompuServe (i386 only):

Log onto CIS and type the following:
Go microsoft
7 (Microsoft Support Forums and Services)
1 (US Product Support)
8 (Microsoft Operating Systems)
6 (Microsoft Windows NT Service Pack Download Area)
Download latest Service Pack for NT 3.51
For Internet Access:

ftp ftp.microsoft.com
logon anonymous



cd bussys/winnt/winnt-public/fixes/nt351
bin
get <Latest Service Pack for NT 3.51>

[Using Help on Windows NT 3.51 Without Service Pack 1]

If the Answer Wizard is launched from the Help menu when a Help topic or
Help dialog is open, Help may not function.

When you are working in a Visual Basic Module in Microsoft Excel, you may
not be able to use context sensitive Help. To use Help in a module, use the
Answer Wizard or the online Help index.

[Removing Earlier Word Version's Help Files From Path statement]

On a machine with both Word 95 and a previous version of Word, Word 95 may
load the previous version's Help files. To correct this, edit the Path
statement in AUTOEXEC.BAT to remove the reference to the previous version's
directory location.

[Using Disks with Distribution Media Format (DMF)]

With the exception of the Setup disk (Disk 1), your Word disks use a new
format called DMF (Distribution Media Format). DMF increases the capacity
of a 3.5-inch floppy disk, which reduces the number of disks needed to
install your application and speeds up installation.

Because DMF is a new format, many existing utilities such as Norton Disk
Doctor, Microsoft ScanDisk, MS-DOS DiskCopy, and Microsoft Windows Copy
Disk do not recognize DMF. You should NOT use disk utilities to examine a
DMF formatted disk, as these utilities can corrupt the DMF disk. You cannot
copy DMF formatted disks using MS-DOS DiskCopy or Microsoft Windows Copy
Disk ( If you want to copy files from the Setup disks, see "Extracting
Files from DMF Disks," later in this file.).

Windows 95, Windows 3.1 (or later), and Windows NT 3.5 (or later) support
DMF.

If there is a chance that your system has a virus, you should run a
recently updated virus detection utility such as F-prot before installing
Word for Windows 95. Otherwise Disk 2 and higher may become infected with
the virus.
Extracting Files from DMF Disks

If you need to copy the Word disks onto a network server or other
permanent storage drive, you may use the copy switch (/C) with the
EXTRACT.EXE utility on Disk 1 to copy the Word installation files to the
target location.

For example, after creating a directory called C:\DISKS on your hard disk
drive for the
Word files, copy all the files on Disk 1 to that directory. (Since Disk 1
does not use DMF, you can use the standard MS-DOS Copy command, COPY
A:\*.* C:\DISKS.) Switch to drive A and type the following command to copy
the
rest of the disks to the directory C:\DISKS:



FOR %I IN (*.*) DO C:\DISKS\EXTRACT /C A:\%I C:\DISKS\%I

A cabinet (.CAB) file includes many files stored as a single file. If you
need only a single file that is contained in one of the cabinet files, you
may search for it using the /D switch with EXTRACT.EXE. Once you find the
file, you can use EXTRACT.EXE again to copy the file to the desired
location. You can also type EXTRACT /? to get help on the EXTRACT command
options. Here are some examples of how to use the EXTRACT command to find
files.

 To list all files in a cabinet file:

EXTRACT /D A:\<cabinet filename>

To list all EXE files in a cabinet file:

EXTRACT /D A:\<cabinet filename> *.EXE

Here are some examples of how to use EXTRACT to copy a single file out of a
cabinet file.

To extract ANY.EXE to the current directory:

EXTRACT A:\<cabinet filename> ANY.EXE

To extract ANY.EXE to C:\OFFICE:

EXTRACT A:\<cabinet filename> /L C:\OFFICE ANY.EXE

[Printing EPS files in Windows 95 or Windows NT]

In both Windows 95 and Windows NT, 32-bit Word documents containing EPS
files do not print properly. Both the bitmap preview and the EPS file will
print, one on top of the other. The workaround for this in both Windows 95
and Windows NT, is to manually take out the PostScript code from the bitmap
preview. To do this, open the PostScript bitmap in a text editor.

[Equation Editor]

MathType is a trademark of Design Science, Inc.
Equation Editor 2.0, a special version of the MathType equation editor from
Design Science, Inc., is customized for use with Microsoft applications,
such as Microsoft [nameofyourapplication] for the
[nameoftheoperatingsystem]. If you work a lot with equations, you may find
that the extended version of Equation Editor is better suited to your
needs. This version includes customizable palettes, a macro feature,
advanced formatting based on tabs, a TeX interface, and the capability for
saving equations as either encapsulated PostScript (EPS) or PICT files.

For further information about MathType, contact Design Science:

Design Science, Inc.
4028 Broadway
Long Beach, CA 90803
Tel. (800) 827-0685 (toll-free in US and Canada)
(310) 433-0685
Fax  (310) 433-6969



Email: mtsales@mathtype.com
WWW: http://www.mathtype.com/mathtype/

International versions are available - contact Design Science for a list of
international distributors.

[Lotus cc:Mail or Lotus Notes]

Word supports Vendor Independent Messaging (VIM) 1.0, which means that you
can use the Send and Add/Edit Routing Slip commands (File menu) in Word to
send or route Word documents with mail applications such as Lotus cc:Mail
that support VIM 1.0.  Lotus cc:Mail 1.11 users may get VIM support files
from Lotus. In order for Word to use VIM mail applications the DOS PATH
command in the AUTOEXEC.BAT file must include the directory in which the
mail application's VIM support files are stored.  If the PATH does not
include the directory containing the VIM support files then setup will not
install VIM support for Word and Word will not function correctly when
sending mail.  The Word support files for VIM 1.0 are called MAPIVI32.DLL
and MAPIVITK.DLL, and both are installed in the System subdirectory of the
Windows program directory.

There are known problems with Lotus Notes 3.3 TCP/IP network protocol
support which are being addressed in a future version of Lotus Notes. These
problems will prevent Word from sending mail through the current versions
of 16 bit Lotus Notes when Lotus Notes is using TCP/IP as its network
protocol.  Using a protocol other than TCP/IP solves the problem.

[Field Codes: Bookmark and REF Fields]

The Help topic "Field Codes: Bookmark and Ref Fields" is incomplete. You
must use the REF field when using the field switches \f and \n. The example
in the description of the \f field switch should be { REF Footnote1 \f }
where "Footnote1" is the bookmark marking the footnote reference mark of
footnote 1.

[Using Word 6.0 or Word 2.0 Templates with Word for Windows 95]

When you install Word for Windows 95, you will find that your old templates
will now appear in the File New dialog box under either the "Shortcut to
Old" or the "Shortcut to Workgroup" tabs. During installation, Setup
locates both your user and workgroup templates' locations and creates a
shortcut folder for each location. The shortcuts are stored in the Office
Templates folder, usually c:\MSOFFICE\TEMPLATES. If Setup does not find a
workgroup templates location, no shortcut folder will be created for it.

Example:
c:\WINWORD\TEMPLATE --> C:\MSOFFICE\TEMPLATES\shortcut to old
\\USER\WORKGRP\TEMPLATE --> c:\MSOFFICE\TEMPLATES\shortcut to workgroup

To use your old templates you can simply choose New from the File menu,
click on either the "Shortcut to Old" or "Shortcut to Workgroup" tab, then
choose your template name from the list of available templates.

To rename the File New tabs that point to your previous templates, use the
Windows Explorer to locate the "Shortcut to Old" or "Shortcut toWorkgroup"
folder and click once on the folder name. You can then type in a new name
which will appear as the name of the tab in the File New dialog.



CAUTION: Deleting your previous templates directory will delete your
previous templates. To best preserve your particular configuration Setup
does not copy or move your previous templates from their original location
to the Office templates directory. Be sure to copy or move your previous
templates before deleting the original directory.

[Word for Windows 95 default setup options]

If you want to find out what is contained in the Typical installation of
Word for Windows 95, choose the Custom option in Setup and look at the
default settings. These defaults are what is included in the Typical
installation.
The following are some of the options that are not installed when you
perform a Typical installation of Word:
Equation Editor
EPS graphics filter
GIF filter
Grammar
WordArt
Find All Word Forms (in the Edit Find/Replace dialog)

[Using Foreign Language Proofing Tools with Word for Windows 95]

Supplemental Foreign language proofing tools purchased for use with Word
6.0 will work with Word for Windows 95. However, when you proof a document
that has foreign language formatting in Word for Windows 95, Word may not
be able to locate the foreign language dictionary file. If you encounter
this problem, copy or move the foreign language dictionary file indicated
in the error message to the following folder: \Program Files\Common
Files\Microsoft Shared\Proof. In most cases, the indicated file will be
located in the folder: \windows\msapps\proof.

To acquire additional language dictionaries, contact:

Alki Software Corporation
300 Queen Anne Ave. N., Suite 410
Seattle, WA  98109
Phone:   (206) 286-2600
Fax:     (206) 286-2785
Support: (206) 286-2780
Orders:  (800) NOW-WORD (669-9673)

[Using Microsoft Bookshelf 1994 with Word for Windows 95]

The Microsoft Bookshelf 1994 integration tools used in Word 6.0 will not
work with Word for Windows 95. If you wish to use these products together,
you should install the Bookshelf Quickshelf toolbar.  Bookshelf 1995 will
have enhanced Word integration features.  Contact your local reseller or
call    the Microsoft Sales Information Center at 1-800-426-9400  for
information about obtaining the updated version of Bookshelf.

[WordBasic Errors with Word 6.0 Add-ins and Macros]

When you upgrade to Word for Windows 95 you may encounter one of the
following error messages while working within Word:



     WordBasic Error = 582: Unable to load specified library

     or

     WordBasic Error = : Invalid library

The most likely cause for this is when you have outdated Global Add-ins or
Templates installed in the File Templates dialog. Some macros and add-ins
are designed to run on 16-bit Windows 3.x and cannot be run on 32-bit
operating systems like Windows 95. Contact the add-in vendor or macro
author for an update. For more information type "WordBasic error 582" in
the Help Find dialog.

[WordMail Information]

By default WordMail uses the EMAIL template for composing and editing
notes. This template is located in your Word templates directory, usually
C:\MSOFFICE\WINWORD. You can customize toolbars, menus, and boilerplate
text in the EMAIL template by opening it in Word and modifying it as you
would any other Word template.

You can switch your default email editor from WordMail to the Exchange
editor by choosing Compose, WordMail Options and checking or clearing the
"Enable Word as Email Editor" check box.

Please note that WordMail requires 12 MB RAM. Using WordMail on systems
with less memory will result in poor performance.

[ODBC Not Included with Word for Windows 95]

The Open Database Connectivity (ODBC) files that provide easy access to
databases created by programs like Microsoft Access, SQL Server, and
Paradox, are not included with standalone Word for Windows 95. Access to
dBASE or FoxPro files is provided by the dBASE converter you can install
via the Custom setup option. Word can use the 32-bit ODBC files included
with Word for Windows 95 and Microsoft Access for Windows 95. You can also
obtain the 32-bit ODBC Drivers Application Note from Microsoft Product
Support Services. For more information on obtaining this application note
refer to the Supplemental Offers Coupon included in this package.

[Windows 95 for Pen Computing]

Support for Windows 95 for Pen Computing is not implemented in Word for
Windows 95.

[Updates to Getting Results with Microsoft Office for Windows 95]

The following are changes that occurred after the book went to press. The
page numbers listed are those in the Getting Results with Microsoft Office
for Windows 95. For those who purchased Word as a separate package, the
page number is in parentheses.

Graphics filters licensed from Henderson Software, Inc., are not part of
the product and should not be on the copyright page.

Pages 27 and 29 (pages 8 and 10): The correct online location of the
Network Install Readme is in the Getting Help section of the Word online



Help table of contents.

Page 28 (page 9): The name of the Remove button has been changed to the
Add/Remove button. Therefore, step 5 should read, "Click the Office
application (click Word), and click the Add/Remove button.

Page 29 (page 10) The correct procedure for starting Word is "click the
Start button, click Programs, and then click Word."

Page 126: The instructions for starting the Memo Wizard should read, "Click
the Memos tab, and then double-click the Memo Wizard." (This is correct in
Getting Results with Microsoft Word for Windows 95.)

Page 538: The reference to the AutoText toolbar button is incorrect.
Instead, you need to click AutoText (Edit menu) to insert AutoText entries.
To learn how to add AutoText (or other tools) to a toolbar, see page 503.
(This is correct in Getting Results with Microsoft Word for Windows 95.)

KBCategory: kbref
KBSubcategory:
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No Result or GP Fault After Clicking Printer Properties Button
Article ID: Q134332
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95 operating system
 - Microsoft Windows NT operating system
--------------------------------------------------------------------------

SYMPTOMS
========

In Word, when you click Print on the File menu, and then click the
Properties button, nothing happens (if you are running Word 7.0 with
Windows 95), or a general protection fault (GP fault) occurs (if you are
running Word 7.0 with Windows NT).

CAUSE
=====

This happens when the printer name ends with a closing (right) parenthesis
or contains the word "on." Word misreads the printer name and cannot carry
out the Properties command.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Rename the printer so that it does not contain the word "on" or end with a
closing parenthesis. Refer to your operating system documentation for
instructions on how to do this.

KBCategory: kbprint buglist7.00
KBSubcategory:
Additional reference words: word95 7.00 gpf word7



Pressing F1 with No File Open Causes Word to Shut Down
Article ID: Q134350
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

If you press F1 in Word when no file is open, you receive the following
error message:

   This program has performed an illegal operation and will be shut down.
   If the problem persists, contact the program vendor.

Word then shuts down. Any changes made to the Normal.Dot template are lost.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. We are researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Make sure a document is open before you press F1, or select the Help menu
instead.

KBCategory: kbui buglist7.00
KBSubcategory:
Additional reference words: word95 7.00 word7



Word 95: "Invalid Page Fault" in Files with Many OLE Objects
Article ID: Q134724
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows NT
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

If you do not have much disk space available and then try to save a file
that contains many OLE objects, you may receive the following error
message:

     WINWORD.EXE caused an invalid page fault in MS095.DLL

-or-

When you try to save the file, the status bar indicates that 100% of the
file is saved, but then you may receive a message indicating that the disk
is full.

If you encounter this problem while you are running Windows 95, Windows may
prompt you to empty the Recycle Bin to free some disk space.

This problem is more likely to occur when you save the file to a floppy
disk.

STATUS
======

Microsoft has confirmed this to be a problem in Microsoft Word for Windows
95 version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

To work around this problem, eliminate some of the OLE objects from the
file, or free some disk space before you save the file.

KBCategory: kbole kberrmsg
KBSubcategory:
Additional reference words: word95 7.00 embedded object word7



Unable to Save WordMail Note to Novell 4.02 Server
Article ID: Q134726
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you try to save a WordMail message to a Novell 4.02 server, you may
receive the following error message:

     Microsoft Word Err=1391 - Word cannot complete the save due to a file
     permission error. (path and filename)

However, Microsoft Word will save the document with a filename that has
been truncated to the MS-DOS 8.3 filename standard. This will happen no
matter what file format you choose to save the WordMail message.

CAUSE
=====

You may receive this error message when Microsoft Word is unable to
determine if the file system on the server to which you are saving the file
supports long filenames. You may also receive this message when you use the
Save As command on the File menu or the FileSaveAs Wordbasic command.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95 version
7.0. Microsoft is researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

To work around this problem, save the file with an 8.3 filename.

MORE INFORMATION
================

The Novell 4.02 server is manufactured by Novell, Inc., a vendor
independent of Microsoft; we make no warranty, implied or otherwise,
regarding this product's performance or reliability.

KBCategory: kbinterop kberrmsg kb3rdparty kbnetwork
KBSubcategory:
Additional reference words: word95 7.00 word7



Application Error When Spell Checking Annotations
Article ID: Q134729
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows, versions 6.0, 6.0a, 6.0c
 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

Performing a spell check on a Word document that is embedded in an Excel
workbook may result in the following error:

     Winword.exe application error. "The instruction at  <addr> referenced
     memory at 0x00"

This error will occur during In-Place Editing of an embedded document that
contains annotations. Canceling the spell check while checking text in the
annotation pane will leave the document vulnerable to this error.

CAUSE
=====

Normally, annotations are unavailable when editing an embedded document
with In Place Editing; however, the speller is still able to open the
annotations pane in this situation.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows version
6.0 and Word for Windows 95 version 7.0. Microsoft is researching this
problem and will post new information here in the Microsoft Knowledge Base
as it becomes available.

WORKAROUND
==========

Do not exit the speller when in the Annotations Pane.

MORE INFORMATION
================

Steps to reproduce problem:

1. Create a document in Word that contains annotations and save it.
2. Start Excel and insert the Word document just saved
   (insert/object/create from file)
3. Double click on the Word object to edit it.
4. Spell check the document and let it get to the annotations pane.
  (it should now be visible)
5. Close the spell checker
6. Place the insertion point in the annotations pane
7. scroll in excel



Result: You will receive the error mentioned above.

KBCategory:
KBSubcategory:
Additional reference words: word95 7.00 word6 word7 6.00 6.00a 6.00a-CD
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CopyFile Command Altered by Hide MS-DOS Extension Option
Article ID: Q134808
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you use the WordBasic command, CopyFile, the copy of the file does not
have an extension. As a result, the copied file loses its association with
Microsoft Word and becomes a generic Windows 95 file. The following code
results in this problem:

   Sub MAIN
   CopyFile "c:\storage\test.doc", "c:\temp"
   End Sub

CAUSE
=====

This problem occurs when the "Hide MS-DOS file extensions for file types
that are registered" is checked in Windows Explorer. (To locate this
option, in Windows Explorer, click Options on the View menu.)

STATUS
======

Microsoft has confirmed this to be a problem in Microsoft Word for Windows
95 version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

RESOLUTION
==========

To work around this problem, use one of the following methods to preserve
the copied file's association with Microsoft Word.

Method 1. Make sure the "Hide MS-DOS file extensions for file types that
          are registered" option in Windows Explorer is not checked.

Method 2. Use the Declare command to make a CopyFileA call to
          Kernel32.dll. To do so, use the following macro:

          Note: The sample assumes that you have a Microsoft Word document
          called "Test.doc" located in the C:\Storage folder.

          Declare Function CopyFileA Lib "kernel32"(a$ As String, b$ As
          String, n As Integer) As Integer

          Sub MAIN
          x = CopyFileA("c:\storage\test.doc", "c:\temp\test.doc ", 3)
          End Sub



WARNING: ANY USE BY YOU OF THE CODE PROVIDED IN THIS ARTICLE IS AT
YOUR OWN RISK. Microsoft provides this macro code "as is" without
warranty of any kind, either expressed or implied, including but not
limited to the implied warranties of merchantability and/or fitness
for a particular purpose.

KBCategory: kbusage
KBSubcategory: kbmacroexample
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Supported, Unsupported Arguments for FileFind Command
Article ID: Q134809
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

This article describes the arguments for the FileFind command that
Microsoft Word for Windows 95 does and does not support.

MORE INFORMATION
================

Microsoft Word for Windows 95 supports the following FileFind arguments:

   SearchPath
   Name
   SubDir
   Title
   Author
   Keywords
   Subject
   MatchCase
   Text
   DateSavedFrom
   DateSavedTo
   SavedBy
   DateCreatedFrom
   DateCreatedTo

Microsoft Word for Windows 95 does not support the following FileFind
arguments:

   SearchName
   Options
   PatternMatch
   View
   SortBy
   ListBy
   SelectedFile
   ShowFolders
   Add
   Delete

KBCategory: kbusage
KBSubcategory: kbmacro
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Missing Text in Help for WordPerfect Users Dialog Boxes
Article ID: Q134814
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you view Help For WordPerfect Users, the top half of the second line
of text in the dialog box is missing.

CAUSE
=====

This behavior occurs when the following conditions are true:

 - The WordPerfect help file is not installed or is missing.

 - You have selected "Help for WordPerfect Users" and "Navigation Keys for
   WordPerfect Users." (To locate these options, click Options on the Tools
   menu, and then click the General tab.)

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

To access WordPerfect help, rerun Setup and install the WordPerfect
help files.

KBCategory: kbui kberrmsg buglist7.00
KBSubcategory: kbhelp
Additional reference words: 7.00 word95 on-line online on line help
for wordperfect users word perfect wpft truncated missing munged, top
word7 half top-half disappeared



Resume Wizard Error: "This Document Template Does Not Exist"
Article ID: Q134816
--------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------

SYMPTOMS
========

When you choose Create a Cover Letter on the last screen of the Resume
Wizard, and then click the Finish button, you may receive the following
error message:

   Microsoft Word Err=1041
   The document template does not exist.

When you click the OK button to cancel the error message, the resume
appears on the screen.

CAUSE
=====

The Resume Wizard does not correctly create the path to find and start the
Letter Wizard.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95 version
7.0. We are researching this problem and will post new information here in
the Microsoft Knowledge Base as it becomes available.

RESOLUTION
==========

To work around this problem, use one of the following methods:

Method 1. Create the cover letter using the Letter Wizard. When you
          select Prewritten Business Letter, the Letter Wizard lists the
          resume cover letter.

Method 2. Modify the StartWizard macro in the Resume Wizard. To do this,
          follow these steps:

          1. Open the Resume Wizard.

          2. On the Tools menu, click Macro.

          3. Select the StartWizard macro, and then click the Edit button.

          4. On the Edit menu, click Find.

          5. In the Find What box, type the following text:



                   rem chk

          6. Press the Find Next button, and then click the Cancel button.
             Note that "Rem chk" (without the quotation marks) is selected.

          7. Move the insertion point before the selected text, and then
             type the following line of WordBasic code:

                If Right$(TPath$,1)<>"\" Then TPath$=TPath$+"\"

          8. Press ENTER, and then press the TAB key on the keyboard three
             times.

          9. Save and close the macro, and then save and close the Resume
             Wizard.

KBCategory: kbusage
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Word 95: How to Change the Default DATE Field Format
Article ID: Q134910
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

This article describes how to change the default Date field format in Word
version 7.0 for Windows 95.

MORE INFORMATION
================

To change the default Date field format, perform the following procedure:

1. On the File menu, click Templates.

2. Click Add.

3. Change to the Macros subfolder under Winword (for example,
   C:\Msoffice\Winword\Macros).

4. Select the Macros7.dot file and click OK. This step adds the Macros7
   template to the "Global Templates and Add-ins" box. Click OK.

5. On the Tools menu, click Macro.

6. In the Macros Available In list, click "Macros7.dot (Global Template)."
   In the Macro Name list, click RegOptions and then click Run.

7. In the Microsoft Word Registry Options dialog box, select the Section
   line for Word 7.0 Options. Change the Option line to DateFormat.

8. On the Setting line, enter the format of the Date field you want, click
   Change, and then click OK.

   For example:

   If you type this for Setting           Your Date result will be
   ----------------------------           ------------------------

     MMMM d, yyyy                         January 2, 1995

     MMMM dd, yyyy                        January 02, 1995

     MMM d, yyyy                          Jan 2, 1995

     dddd, MMMM d, yyyy                   Monday, January 2, 1995

     h:mm am/pm dddd, MMMM d              10:00 am Monday, January 2

9. For this Date format change to take effect, restart Word. Use



   ALT+SHIFT+D to insert the Date field into your document with the new
   default Date format.

KBCategory: kbusage
KBSubcategory: kbfields
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Unable to Save Preview Picture in a Master Document
Article ID: Q134911
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

After you select Save Preview Picture in a Master Document and save the
document, when you reopen the document, the setting is no longer selected.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Although you can't save a preview picture for a master document, you can
save the Save Preview Picture setting in the subdocuments of your master
document.

KBCategory: kbother buglist7.00
KBSubcategory:
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Word 95: Previous Templates Not Available in New Dialog Box
Article ID: Q134912
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

After installing Word 7.0 to a new folder, templates that were available in
the Word 6.0 New dialog box seem to be missing from Word 7.0.

CAUSE
=====

The templates are available in the Word 7.0 New dialog box, under a tab
called "Shortcut to Old," for your local templates, or "Shortcut to
Workgroup," for your workgroup templates.

NOTE: If you deleted your Word 6.0 installation, including the Word 6.0
templates directory, after installing Word 7.0, these tabs may not appear
at all, or they may have nothing in them because the templates the
shortcuts point to no longer exist. If this is the case, you will need to
use Word 7.0 to re-create the templates that you used in Word 6.0.

RESOLUTION
==========

You can use one of the following methods to control the way the Word 6.0
templates appear in the New dialog box:

Method 1: Move or copy the templates from the Word 6.0 folder to the Word
          7.0 templates folder (c:\Msoffice\Templates by default). If you
          copy the folder, this duplicates the Word 6.0 templates and
          requires more disk space.

Method 2: Personalize the tab name by using Windows Explorer to locate the
          "Shortcut to Old" or "Shortcut to Workgroup" folder (whichever
          appears in your New dialog box) and click once on the folder
          name. You can then type a new name. This new name will appear on
          the tab in the New dialog box. This method allows you to retain
          both Word 6.0 and Word 7.0 and use one set of templates for both
          versions of Word.

MORE INFORMATION
================

During installation, Setup finds both your user and workgroup templates and
creates a shortcut folder for each location. The shortcuts are stored in
the Office Templates folder, usually C:\Msoffice\Templates. If Setup does
not find workgroup templates, no shortcut folder will be created for it.

Example:



   C:\Winword\Template --> C:\Msoffice\Templates\Shortcut to old
   \\User\Workgrp\Template --> C:\Msoffice\Templates\Shortcut to Workgroup

CAUTION: Deleting your previous templates directory will delete your
previous templates. To best preserve your particular configuration, Setup
does not copy or move your previous templates from their original location
to the Office templates directory. Be sure to copy or move your previous
templates before deleting the original directory.

REFERENCES
==========

Wdreadme.txt file

KBCategory: kbusage
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Sizes and Sources of Alki Foreign Language Proofing Tools
Article ID: Q134995
-------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
-------------------------------------------------------------------

SUMMARY
=======

The following is a list of the sizes (in words) and sources of the foreign
proofing tools supplied by Alki Software.

MORE INFORMATION
================

Speller
=======

Language                   Words              Source of Vocabulary
--------                   -----              --------------------

US English                 106,000            HMCo, Brown Corpus,

UK English                 107,700            HMCo, Lancaster-
                                              Oslo/Bergen Corpus

US English (Comprehensive) 189,400

UK English (Comprehensive) 191,100

Australian English         178,100            Macquarie PTY Ltd.

Catalan                    241,100            University of Barcelona

Czech                      6,166,200          Jan Hajic

Danish                     257,600            Munksgaard

Dutch                      226,900            Celex

Finnish                    196,800            Kielikone Oy

French                     262,100            Larousse

French Canadian            262,100            Larousse

German                     383,800            Langenscheidt

Hungarian                  80,000 (keywords)
                           1 billion (derived words)

Italian                    359,300            Zanichelli

Norwegian Bokmal           273,800            Dr. Kolbjorn Heggstad



Norwegian Nynorsk          241,400            Dr. Kolbjorn Heggstad

Polish                     54,000 (keywords)
                           722,000 (derived words)

Portuguese Brazilian       200,200            HMCo

Portuguese Iberian         194,100            Porto Editora

Russian                    1,055,400          HMCo

Spanish                    400,300            Larousse, HMCo

Swedish                    254,700            Sprakdata, HMCo

Turkish                    30,000 (keywords)
                           10 billion (derived words)

Thesaurus
=========

Language                   Keywords    Approximate   Sources
                                       Synonyms
--------                   --------    -----------   -------

US English                 44,000      458,000

UK English                 25,000      200,000

US English (comprehensive) 50,000      600,000

Catalan                    34,000                    Bibliograf S.A.

Danish                     23,000      180,000

Dutch                      22,000      150,000

Finnish                    8,000                     Kielikone Oy

French                     23,000      180,000

French Canadian            24,000      180,000

German                     60,000      600,000

Italian                    16,000      150,000

Norwegian                  24,000      190,000

Portuguese Brazilian       116,001                   Nova Fronteira

Portuguese Iberian                                   Porto Editora

Spanish                    43,000      650,000

Swedish                    63,000      620,000



KBCategory: kbusage
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Troubleshooting Proofing Tool Error Messages in Word 95
Article ID: Q134996
-------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
-------------------------------------------------------------------

SUMMARY
=======

The following information discusses error messages specific to the Word for
Windows 95 proofing tools and methods, for the purpose of troubleshooting
those error messages.

MORE INFORMATION
================

Shared Alerts
=============

Spelling, grammar, hyphenation, and thesaurus have four shared main error
alerts, as well as a few others specific to each tool. The shared alerts
are:

   Word cannot find (tool x) for (language x).
   Word cannot read (tool x) for (language x).
   Word cannot open (tool x) for (language x).
   Word cannot load (tool x) for (language x).

These messages narrow down the possible problem. The verb in each message
is the key word.

"Cannot find" means either the tool is not in the expected location on the
disk or, if there is a path listed for the tool, the tool is registered in
a location other than where it is installed.

"Cannot read" means Word can find the tool, but Word is unable to tell how
to use it. This could be caused by a bad or corrupted file.

"Cannot open" means Word can find the tool and is able to understand how it
should be used, but Word can't actually open it. This too is usually a bad
or corrupted file.

"Cannot load" means Word can find the tool, read the tool, and open the
tool, but Word can't load it for use. This can be triggered by a bad file,
a corrupted file, or a low-memory condition.

Troubleshooting the Error Messages
==================================

Error 1: Word cannot start the (tool).
--------------------------------------

Solution: Word is unable to start the tool mentioned in the message due to
some sort of error. Possible causes include:



 - Not enough memory.
 - Your computer hung (stopped responding) while running the tool,
   and  you need to restart Windows before using the tool again.
 - The file or files are correctly installed but incorrectly
   registered (or correctly registered and incorrectly installed).
 - Decompression of the file by Setup was unsuccessful.

Error 2: There is not enough memory to run the (tool).
------------------------------------------------------

Solution: This is the catch-all error in Word.

 - There is a low memory situation. Try closing other programs to clear
   memory or try restarting the system.
 - The problem may be a corrupted document.

Error 3: The (tool) is in use.
------------------------------

Solution: This message should no longer appear with any of the tools, as
all are "re-entrant" after the computer hangs. If the message does appear,
it indicates that you were in the process of using the tool when a file,
application, or system error occurred. These errors usually include hangs
or general protection faults (GP faults).

 - Clear out unnecessary *.tmp files and restart Windows.

Hyphenation-Specific Errors
===========================

Error: Word cannot find the hyphenation file HYPH32.DLL for English (US).

Solution: The document open was created with AutoHyphenation turned on and
you do not have the hyphenation files installed.

KBCategory: kbusage kbtshoot
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General Proofing Tool Information for Word for Windows 95
Article ID: Q134997
-------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
-------------------------------------------------------------------------

SUMMARY
=======

The following is general information about the proofing tools for Word for
Windows 95.

MORE INFORMATION
================

Filenames
=========

The following are the filenames for the US proofing tools. The spelling and
hyphenation .lex files support both US and UK English. To get the UK
option, format text as UK English.

   Tool              Filenames (.dll, .lex)
   ----              ----------------------

   Speller           Mssp232.dll, Mssp2_en.lex
   Thesaurus         Msth32.dll,  Msth_Am.lex
   Hyphenation       Hyph32.dll,  Hy_En.lex
   Grammar           Gram32.dll,  Gr_Am.lex

Location of the Tools
=====================

For Windows 95
--------------

The speller and thesaurus are placed in the shared Office for Window 95
folder (Program Files\Common Tools\Proof) because these tools may be used
by other Microsoft programs. In a network installation, the shared tools
may be placed elsewhere.

The hyphenation and grammar tools are placed in the private Word for
Windows 95 folder.

For Windows NT 3.51 Setups
--------------------------

The speller and thesaurus are placed in the shared Windows NT folder
(Winnt35\msapps\proof) because these tools may be used by other Microsoft
programs. In a network installation, the shared tools may be placed
elsewhere.

The hyphenation and grammar tools are placed in the private Word for
Windows 95 folder.



The Word for Windows 95 speller and grammar checker should overwrite the
Word 6.0 for Windows NT files, as the version numbers are incremented. The
.lex files for all the tools should be updated, if necessary.

Coexistence with Soft-Art Speller
=================================

The Word for Windows 95 Inso speller (Mssp232.dll) will coexist with the
Soft-Art speller (Mssp32.dll) in the shared directory if they both support
one or more different languages. If not, Word for Windows 95 Setup replaces
the Soft-Art speller with the Word speller, because Word's speller is
better, and so that other programs can use it.

The Soft-Art speller ships with Microsoft Excel for Windows NT, Microsoft
Excel for Windows 95, Windows 95 Exchange, Works for Windows 95, PowerPoint
for Windows 95, FoxPro for Windows 95, and Microsoft Access for Windows 95.
Office for Windows 95 ships only the Inso speller.

.Ini Entries
============

For Word and Office for Windows 95, the path lines for the proofing tools
are written to the registry, instead of to the Winword6.ini file under the
[Microsoft Word] section, and/or to the Win.ini file under the [MS Proofing
Tools] section.

Setup registers the shared tools, including custom dictionaries, to the
HKEY_LOCAL_MACHINE location under Software\Microsoft\Shared Tools\Proofing
Tools.

Setup registers the grammar checker and the hyphenator to the
HKEY_CURRENT_USER location under Software\Microsoft\Word\7.0\Proofing
Tools. All the tools are also self-registered to this location if the
registry is damaged or changed and the tools are in one of the expected
locations for self-registering (see more information on the search
hierarchy below).

For Users with Alki PTKs Installed
----------------------------------

Alki has given Microsoft a custom MigrateProofTools action that is
incorporated in the Word and Office for Windows 95 Setup programs. This
action kicks in after all the tools have been installed by the current
Setup being run. MigrateProofTools looks at the entries in the Win.ini and
Winword6.ini files and causes any tools listed therein to be registered in
the Windows 95 registry. This custom action does not move the proofing
tools already installed but instead points to them by means of the
registry.

Installing Word for Windows 95 over Word 6.0
--------------------------------------------

The Word 6.0 proofing dictionaries are fully compatible with Word for
Windows 95. You should have no need to upgrade your Alki Software Proofing
Tool Kit, unless you need a kit containing the Inso thesaurus (Portuguese
Brazilian, Portuguese Iberian, Catalan, or Finnish), or the French,



Italian, or Russian grammar checkers. These tools were not upgraded to 32-
bit packages for Word 6.0 for Windows NT, so if you have the kit for Word
6.0 for Windows, you need to upgrade the kit to get the 32-bit engine.
There may also have been changes to other Eastern European tools. I you
have questions, contact Alki Software.

To upgrade Word 2.0x for Windows proofing tools or to buy additional
foreign language proofing tools, contact Alki Software. Alki supplies
foreign language proofing tool kits and specialized proofing tools
(comprehensive US & UK English speller and hyphenation, which includes
Medical and Legal terms, and comprehensive US English thesaurus).

   ALKI SOFTWARE CORPORATION
   300 Queen Anne Avenue N., Suite 410
   Seattle, WA 98109

   Phone:  (206) 286-2600
   Fax:    (206) 286-2785
   Orders: (800) NOW-WORD (669-9673)

Installation Note: Alki proposes that the private tools be installed in the
Proof folder, which is a subfolder of the Word program folder, and the
shared tools to be installed in the shared tools directory.

Compatibility with the Softart Proofing Tools
=============================================

Word for Windows 95 continues to be CSAPI compliant and is fully compatible
with the Softart 32-bit Mssp32.dll and its Mssp_xx.lex files.

The thesaurus is now fully CTAPI compliant.

The Inso and Softart thesaurus files are now fully enabled for sharing by
other programs.
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Keyboard Shortcuts in Word 7.0 for Windows 95
Article ID: Q135000
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

The following is a list of keyboard shortcuts available in Word 7.0. This
list is a compilation of the individual keyboard shortcut lists available
in Word Help.

Function Key Shortcuts
======================

                                          CTRL+                  ALT+
                  SHIFT+      CTRL+       SHIFT+      ALT+       SHIFT+
Key  Key Only     Key         Key         Key         Key        Key
--------------------------------------------------------------------------
F1   Get Online   Reveal                              Next       Previous
     Help or the  Formatting                          Field      Field
     Answer
     Wizard
--------------------------------------------------------------------------
F2   Move text    Copy text   Print                              Save
     or graphics              preview                            command
                              command                            (File
                              (File Menu)                        Menu)
--------------------------------------------------------------------------
F3   Insert an    Change the  Cut to     Insert
     AutoText     case of     spike      contents of
     entry        letters                the spike
--------------------------------------------------------------------------
F4   Repeat the   Repeat a    Close the               Exit
     last action  Find or     window
                  GoTo
                  action
--------------------------------------------------------------------------
F5   Carry out    Move to a   Restore    Edit a
     the GoTo     previous    the        bookmark
     command      revision    window
     (Edit menu)              size
--------------------------------------------------------------------------
F6   Go to next   Go to       Go to      Go to
     pane         previous    next       previous
                  pane        window     window
--------------------------------------------------------------------------
F7   Carry out    Carry out   Carry out  Update       Find next
     the          the         the Move   linked       misspelling
     Spelling     Thesaurus   command    information  (Automatic
     command      command     (Control   on a Word    Spell
     (Tools       (Tools      menu)      source       Checking
     menu)        menu)                  document     enabled)



--------------------------------------------------------------------------
F8   Extend a     Shrink a    Carry out  Extend a
     selection    selection   the Size   selection
                              command    (or block)
                              (Document
                              Control
                              menu)
--------------------------------------------------------------------------
F9    Update      Switch      Insert an  Unlink a     Switch     Run
      selected    between a   empty      field        between    GOTO-
      fields      field code  field                   all field  BUTTON
                  and its                             codes and  or MACRO-
                  result                              all        BUTTON
                                                      results    from the
                                                                field that
                                                                 displays
                                                                 the field
                                                                 results
--------------------------------------------------------------------------
F10   Activate    Display a   Maximize   Activate     Maximize
      the menu    shortcut    the        the ruler    the
      bar         menu        document                application
                              window                  window
--------------------------------------------------------------------------
F11   Go to the   Go to the   Lock a     Unlock a
      next field  previous    field      field
                  field
--------------------------------------------------------------------------
F12   Carry out   Carry out   Carry out  Carry out
      the Save As the Save    the Open   the Print
      command     command     command    command
      (File menu) (File menu) (File menu)(File menu)
--------------------------------------------------------------------------

Apply Formatting Using Shortcut Keys
====================================

Format Characters Using Shortcut Keys
-------------------------------------

Change the font                               CTRL+SHIFT+F
Change the font size                          CTRL+SHIFT+P
Increase the font size                        CTRL+SHIFT+>
Decrease the font size                        CTRL+SHIFT+<
Increase the font size by 1 point             CTRL+]
Decrease the font size by 1 point             CTRL+[

Change the case of letters                    SHIFT+F3
Format letters as all capitals                CTRL+SHIFT+A
Apply or remove bold formatting               CTRL+B
Apply or remove an underline                  CTRL+U
Underline single words                        CTRL+SHIFT+W
Double-underline text                         CTRL+SHIFT+D
Apply or remove hidden text                   CTRL+SHIFT+H
Apply italic formatting                       CTRL+I
Format letters as small capitals              CTRL+SHIFT+K
Apply subscripts (automatic spacing)          CTRL+EQUAL SIGN



Apply superscripts (automatic spacing)        CTRL+SHIFT+EQUAL SIGN
Remove formatting (plain text)                CTRL+SHIFT+Z
Change the selection to Symbol font           CTRL+SHIFT+Q

Display nonprinting characters                CTRL+SHIFT+* (asterisk)

Format Paragraphs Using Shortcut Keys
-------------------------------------

Single-space lines                            CTRL+1
Double-space lines                            CTRL+2
Set 1.5-line spacing                          CTRL+5
Add one line of space preceding text          CTRL+0 (zero)
Remove the space preceding text               CTRL+0 (zero)

Center a paragraph                            CTRL+E
Justify a paragraph                           CTRL+J
Left align a paragraph                        CTRL+L
Right align a paragraph                       CTRL+R
Indent a paragraph from the left              CTRL+M
Remove a paragraph indent from the left       CTRL+SHIFT+M
Create a hanging indent                       CTRL+T
Reduce a hanging indent                       CTRL+SHIFT+T
Remove paragraph formatting                   CTRL+Q

Apply a style (with the Formatting
               toolbar displayed)             CTRL+SHIFT+S
Carry out the Style command (Format menu)
  (Formatting toolbar not displayed)          CTRL+SHIFT+S
Start AutoFormat                              CTRL+K
Apply the Normal style                        CTRL+SHIFT+N
Apply the Heading 1 style                     ALT+CTRL +1
Apply the Heading 2 style                     ALT+CTRL +2
Apply the Heading 3 style                     ALT+CTRL +3
Apply the List style                          CTRL+SHIFT+L

Edit and Move Text Using Shortcut Keys
======================================

Copy and Move Text and Graphics Using Shortcut Keys
---------------------------------------------------

Copy text or graphics                         CTRL+C
Copy formats                                  CTRL+SHIFT+C
Move text or graphics                         F2
Paste text or graphics                        CTRL+V
Paste formats                                 CTRL+SHIFT+V

Delete Text and Graphics Using Shortcut Keys
--------------------------------------------

Delete one character to the left              BACKSPACE
Delete one word to the left                   CTRL+BACKSPACE
Delete one character to the right             DELETE
Delete one word to the right                  CTRL+DELETE
Cut selected text to the Clipboard            CTRL+X
Undo the last action                          CTRL+Z



Cut to the Spike                              CTRL+F3

Insert Special Characters
-------------------------

Field                                         CTRL+F9
AutoText entry                                Type AutoText entry name,
                                              and then press ALT+CTRL+V
Line break                                    SHIFT+ENTER
Page break                                    CTRL+ENTER
Column break                                  CTRL+SHIFT+ENTER
Optional hyphen                               CTRL+HYPHEN
Nonbreaking hyphen                            CTRL+SHIFT+HYPHEN
Nonbreaking space                             CTRL+SHIFT+SPACEBAR
Copyright symbol                              ALT+CTRL+C
Registered trademark symbol                   ALT+CTRL+R
Trademark symbol                              ALT+CTRL+T
Ellipsis                                      ALT+CTRL+PERIOD
Single opening quotation mark                 CTRL+`'`
Single closing quotation mark                 CTRL+`'`
Double opening quotation mark                 CTRL+`"`
Double closing quotation mark                 CTRL+`"`
Mark a table of contents entry                ALT+SHIFT+O
View Spike contents                           CTRL+SHIFT+F3

Select Text and Graphics Using Shortcut Keys
--------------------------------------------

Note: Select text by holding down SHIFT and pressing keys that move the
insertion point.

One character to the right                    SHIFT+RIGHT ARROW
One character to the left                     SHIFT+LEFT ARROW
To the end of a word                          CTRL+SHIFT+RIGHT ARROW
To the beginning of a word                    CTRL+SHIFT+LEFT ARROW
To the end of a line                          SHIFT+END
To the beginning of a line                    SHIFT+HOME
One line down                                 SHIFT+DOWN ARROW
One line up                                   SHIFT+UP ARROW
To the end of a paragraph                     CTRL+SHIFT+DOWN ARROW
To the beginning of a paragraph               CTRL+SHIFT+UP ARROW
One screen down                               SHIFT+PAGE DOWN
One screen up                                 SHIFT+PAGE UP
To the end of a document                      CTRL+SHIFT+ END
To the beginning of a document                CTRL+SHIFT+ HOME
To include the entire document                CTRL+A
To a vertical block of text                   CTRL+SHIFT+F8, and then use
                                                the arrow keys; press ESC
                                                to cancel selection mode
To a specific location in a document          F8+arrow keys; press ESC to
                                                cancel selection mode

Tip:  If you know the key combination to move the insertion point, you can
select the text by using the same key combination while holding down SHIFT.
For example, CTRL+RIGHT ARROW moves the insertion point to the next word,
and CTRL+SHIFT+RIGHT ARROW selects the text from the insertion point to the
beginning of the next word.



Select Text and Graphics in a Table Using Shortcut Keys
-------------------------------------------------------

Select a column                               ALT and hold it down while
                                                you click the column
Extend a selection (or block)                 CTRL+SHIFT+F8, and then use
                                                the arrow keys
Reduce the selection size                     SHIFT+F8
Select an entire table                        ALT+5 on the numeric keypad

Extend a Selection Using Shortcut Keys
--------------------------------------

Select the nearest character                  F8+character
Turn extend mode on or off                    F8
Reduce the size of a selection                SHIFT+F8

Move to a Character, Word, Paragraph, Column,
or Object Using Shortcut keys
----------------------------------------------

One character to the left                     LEFT ARROW
One character to the right                    RIGHT ARROW
One word to the left                          CTRL+LEFT ARROW
One word to the right                         CTRL+RIGHT ARROW
One paragraph up                              CTRL+UP ARROW
One paragraph down                            CTRL+DOWN ARROW
To the previous frame or object               ALT+UP ARROW
To the next frame or object                   ALT+DOWN ARROW
One column to the left (in a table)           SHIFT+TAB
One column to the right (in a table)          TAB
To the next misspelling
(Automatic Spell Checking enabled)            SHIFT+BACKSPACE

Move to a Line, a Page, a Screen, the Beginning or End of a Document, or
the Previous Revision Using Shortcut Keys
------------------------------------------------------------------------

Up one line                                   UP ARROW
Down one line                                 DOWN ARROW
To the end of a line                          END
To the beginning of a line                    HOME
Up one page                                   ALT+CTRL+PAGE UP
Down one page                                 ALT+CTRL+PAGE DOWN
Up one screen                                 PAGE UP
Down one screen                               PAGE DOWN
To the bottom of a screen                     CTRL+PAGE DOWN
To the top of a screen                        CTRL+PAGE UP
To the end of a document                      CTRL+END
To the beginning of a document                CTRL+HOME
To a previous revision                        SHIFT+F5
To the location of the insertion point
  when the document was last closed           SHIFT+F5

Move Around in a Table Using Shortcut Keys
------------------------------------------



Next cell in a row                            TAB
Previous cell in a row                        SHIFT+TAB
First cell in a row                           ALT+HOME
First cell in a column                        ALT+PAGE UP
Last cell in a row                            ALT+END
Last cell in a column                         ALT+PAGE DOWN
Previous row                                  UP ARROW
Next row                                      DOWN ARROW

Insert Paragraphs and Tab Characters Using Shortcut Keys
--------------------------------------------------------

New paragraphs in a cell                      ENTER
Tab characters in a cell                      CTRL+TAB

Merge Documents Using Shortcut Keys
===================================

Preview a mail merge                          ALT+SHIFT+K
Merge a document                              ALT+SHIFT+N
Print the merged document                     ALT+SHIFT+M
Edit a mail merge data document               ALT+SHIFT+E
Insert a merge field                          ALT+SHIFT+F

Print and Preview a Document Using Shortcut Keys
================================================

Print command (File menu)                     CTRL+P

Move around the page when zoomed in           Arrow keys
Move by one page when zoomed out              PAGE UP or PAGE DOWN
Move to the first page when zoomed out        CTRL+UP ARROW or
                                                CTRL+LEFT ARROW
Move to the last page when zoomed out         CTRL+DOWN ARROW or
                                                CTRL+RIGHT ARROW

Work with Fields Using Shortcut Keys
====================================

DATE field                                    ALT+SHIFT+D
PAGE field                                    ALT+SHIFT+P
TIME field                                    ALT+SHIFT+T
Empty field                                   CTRL+F9

Update linked information in a Word
  source document                             CTRL+SHIFT+F7
Update selected fields                        F9
Unlink a field                                CTRL+SHIFT+F9
Switch between a field code and its result    SHIFT+F9
Switch between all field codes and
  all results                                 ALT+F9
Run a GOTOBUTTON or MACROBUTTON from the
  field that displays the field results       ALT+SHIFT+F9
Go to the next field                          F11
Go to the previous field                      SHIFT+F11
Lock a field                                  CTRL+F11



Unlock a field                                CTRL+SHIFT+F11

Work with Menus Using Shortcut Keys
===================================

You can choose any menu command with the keyboard. Press ALT+ the letter
underlined in the menu name, and then press the letter underlined in the
command name.

Display the shortcut menu                     SHIFT+F10
Display the application Control menu          SPACEBAR (when the menu bar
                                                        is active)
Select the next or previous command
  on the menu                                 DOWN ARROW or UP ARROW
                                              (with the menu displayed)
Select the menu to the left or right;
  or, with a submenu displayed, toggle
  the selection between the main menu
  and the submenu                             LEFT ARROW or RIGHT ARROW

Work on an Outline Using Shortcut Keys
======================================

Promote a paragraph                           ALT+SHIFT+LEFT ARROW
Demote a paragraph                            ALT+SHIFT+RIGHT ARROW
Demote to body text                           CTRL+SHIFT+N
Move selected paragraphs up                   ALT+SHIFT+UP ARROW
Move selected paragraphs down                 ALT+SHIFT+DOWN ARROW

Expand text under a heading                   ALT+SHIFT+PLUS SIGN
Collapse text under a heading                 ALT+SHIFT+MINUS SIGN
Show all text or headings                     ALT+SHIFT+A
Display all text                              Asterisk (*) key on the
                                                numeric keypad
Hide or display character formatting          Slash (/) key on the numeric
                                                keypad
Show the first line of body text or
  all body text                               ALT+SHIFT+L
Show all headings with the Heading 1 style    ALT +SHIFT+1
Show all headings up to Heading n             ALT +SHIFT+n

Work in Windows and Dialog Boxes
================================

Work in Windows
---------------

Next application                              ALT+TAB
Previous application                          ALT+SHIFT+TAB
Start menu                                    CTRL+ESC
Close the window                              CTRL+F4
Restore the window size                       CTRL+F5
Switch to the next window                     CTRL+F6
Switch to the previous window                 CTRL+SHIFT+F6
Carry out the Move command (Control menu)     CTRL+F7
Carry out the Size command (Control menu)     CTRL+F8
Maximize the window                           CTRL+F10



Select a folder in the Open or
  Save As dialog box (File menu)              ALT+0, and then use the
                                                arrow keys
Choose a toolbar button in the Open or
  Save As dialog box (File menu)              ALT+ number (1 is the
                                                leftmost button, 2 is the
                                                next, and so on)
Refresh the Open or Save As dialog box
  (File menu)                                 F5

Work in Dialog Boxes Using Shortcut Keys
----------------------------------------

Switch to the next tab in a tab dialog box    CTRL+TAB or CTRL+PAGE DOWN
Switch to the previous tab in a tab
  dialog box                                  CTRL+SHIFT+TAB or
                                                CTRL+PAGE UP
Move to the next option or group of
  option buttons                              TAB
Move to the previous option or group
  of option buttons                           SHIFT+TAB
Move within the active list box or group
  of option buttons                           Arrow key
Select the active command button or
  check box                                   SPACEBAR
Move to the next item beginning with that
  letter in an active list box                Letter key
Select the item with that underlined letter   ALT+ letter key
Display a drop-down list box                  ALT+DOWN ARROW
Close a drop-down list box                    ESC
Choose the default command button             ENTER
Cancel the command and close the dialog box   ESC

Within a Text Box
-----------------

Move to the beginning or end of the entry     HOME or END
Move one character to the left or right       LEFT ARROW or RIGHT ARROW
Select from the insertion point to the
  beginning of the entry                      SHIFT+HOME
Select from the insertion point to the
  end of the entry                            SHIFT+END
Select the character to the left              SHIFT+LEFT ARROW
Select the character to the right             SHIFT+RIGHT ARROW

KBCategory: kbref
KBSubcategory:
Additional reference words: 7.00 word95 word7



Answer Wizard Allows Access to Removed Menu Commands
Article ID: Q135091
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

The Answer Wizard may give you access to a command that you removed from
its menu, or the command functions differently when accessed through the
Answer Wizard than when you choose the command from the menu.

CAUSE
=====

This behavior occurs because the Answer Wizard directly accesses the
original, unmodified Word commands. The result may not match what is
available to you if you have modified your menus (with the Tools Customize
command) or if you substituted custom macros for existing menu commands.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95 version
7.0. Microsoft is researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

KBCategory: kbusage buglist7.00
KBSubcategory:
Additional reference words: word95 7.00 word7



No Browse Button in Style Gallery
Article ID: Q135230
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

There is no Browse button in the Style Gallery (Format menu).  By
contrast, Word version 6.0 included a Browse button in the Style
Gallery, which allowed you to select a different template folder.

STATUS
======

Microsoft is researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Modify the paths for the User Templates or Workgroup Templates and
then go to the Style Gallery.  To do this, click Options on the Tools
menu, and then click the File Locations tab.

KBCategory: kbusage
KBSubcategory: kbformat
Additional reference words: 7.00 word95 style gallery browse button
word7 templates directory folder



Grammar Checker, Word 2.0 Converter Missing from Typical Setup
Article ID: Q135238
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When running Word for Windows 95, you notice several components are
missing. For example:

 - The Grammar command is missing from the Tools menu, or when you look
   under Tools Options, the Grammar tab is unavailable (dimmed).

 - In the File Save As box, the option to save a file as Word 2.x is
   missing.

CAUSE
=====

The grammar checker and the Word 2.0 converter are among the components not
installed with a Typical installation. Shared applications such as WordArt
and Equation Editor, as well as most graphics filters, are also not
installed when you choose Typical during Setup.

RESOLUTION
==========

If you want to add these components, run Setup and add them using the
Add/Remove button.

MORE INFORMATION
================

Below is a list of the components that are not installed with a Typical
setup in an Office installation and in a stand-alone Word installation.

Microsoft Office for Windows95 Install
--------------------------------------

     Word Components Not Installed
          Online Help Components (partial)
               WordBasic Help
               Help for WordPerfect Users

          Templates, Wizards, and Letters (partial)
               Forms
               More Wizards
               Newsletters
               Press Releases
               Publications
               Resumes
               Table Wizard



               Sample Letters
               Macro Templates

          Proofing Tools (partial)
               Grammar Checker

          WordMail (requires 12 MB of RAM)

          Dialog Editor

          Text Converters

     Office Tools (partial)
          WordArt
          Organizational Chart
          Equation Editor
          Additional Sounds
          Find All Word Forms
          Clip Art (partial)
               Word Clip Art

     Converter, Filters, and Data Access (partial)
          Converters
               Word 2.0 converter
               Word for the Macintosh converters for versions 4-5.1
               Word for MS-DOS converters for versions 3-6
               RFT-DCA Converter
               Windows Write Converter
               MS Works for Windows version 3.0
               MS Works for Windows version 4.0
               WordStar converters

          Graphic Filters
               EPS
               Targa
               AutoCad DXF
               CGM
               PCX
               Micrografx Designer
               CorelDraw
               HP Graphics Language
               CompuServe GIF
               Kodak Photo CD

          Data Access

Microsoft Word for Windows 95, Version 7.0 Install
--------------------------------------------------

     Shared Applications
          Equation Editor
          MS Graph 5.0
          Word Art

     Proofing Tools
          Grammar Checker



     Converters and Filters
          Converters
               Word for Windows 2.0 Converter
               Word for Macintosh 4.0-5.1 Converter
               Word for MS-DOS 3.0-6.0 Converter
               RFT-DCA
               Write for Windows Converter
               Microsoft Works for Windows 3.0 Converter
               Microsoft Works for Windows 4.0 Converter
               WordStar Converter
               Lotus 1-2-3 Converter
               Text with Layout Converter
               FoxPro/dBASE Converter

          Graphics Filters
               EPS
               Targa
               AutoCad DXF
               CGM
               PCX
               Micrografx Designer
               CorelDraw
               HP Graphics Language
               CompuServe GIF
               Kodak Photo CD

     Online Help
          WordBasic Help
          Help for WordPerfect Users

     Templates, Wizards, and Letters
          Forms
          More Wizards
          Newsletters
          Press Releases
          Publications
          Resumes
          Table Wizard
          Sample Letters
          Macro Templates

     Word Tools
          WordMail (needs 12 MB of RAM)
          Find All Word Forms
          Dialog Editor

For additional information, please see the following article in the
Microsoft Knowledge Base:

   ARTICLE-ID: Q133796
   TITLE     : Word 7.0 Installation Types and Space Requirements

KBCategory: kbsetup
KBSubcategory:
Additional reference words: word95 7.00 word7



Can't Set Margin, Tab in Merged Table Cell
Article ID: Q135283
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows, version 6.0, 6.0a, 6.0c
 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you open a Word 2.0 document that contains a table with merged
cells into Word 6.0 or Word 7.0, you will see the following problems
when you place your cursor in the merged cell:

 - The margin release indicators on the ruler are missing.

 - Tabs can not be set by clicking on the ruler.

 - Although the tab indicators do not display on the ruler if you set tabs
   from the Format menu, you can use them.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

WORKAROUND
==========

Select the table cells, click Split Cells on the Table menu, and then
remerge the cells. The margin release indicators and the tab stops
will display on the ruler.

KBCategory: kbinterop
KBSubcategory: kbformat kbtable
Additional reference words: 7.00 word95 tabs table merged merge cells
word7 word6 tab stops position



Caption Buttons for Document Window Appear as Black Boxes
Article ID: Q135284
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

The caption buttons for minimize, maximize, and close appear as black
boxes.

CAUSE
=====

You modified your display properties and applied Bold formatting to
the Menu item font.  (To locate this option, open the Windows Control
Panel, double-click the Display icon, and then click on the
Appearance tab.)

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

WORKAROUND
==========

Method 1. Remove the bold formatting for the Menu item. To do this,

          a. Open the Windows Control Panel.
          b. Double-click the Display icon.
          c. Click on the Appearance tab.
          d. In the Item drop-down list, point to Menu.
          e. Click the Bold button to turn off bold formatting.
          f. Click Apply.
          g. Click OK.

Method 2. Use a font that is already bold. To do this,

          a. Open the Windows Control Panel.
          b. Double-click the Display icon.
          c. Click on the Appearance tab.
          d. In the Item drop-down list, point to Menu.
          e. In the Font drop-down list, choose a font such as Arial Black
             or Arial Rounded MT Bold.
          f. Click Apply.
          g. Click OK.

KBCategory: kbenv



KBSubcategory:
Additional reference words: 7.00 word95 caption button buttons word7
box menu item display properties property



"Value Entered Does Not Match With the Specified Type"
Article ID: Q135285
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

You get the following error message when you define a custom property
of type Date when the value includes hyphens.

   The value entered does not match with the specified type.
   The value will be stored as text.

CAUSE
=====

The Regional Settings for Short Date Style and Date Separator are
defined using a slash (/) instead of a hyphen.  (To locate this
option, open the Windows Control Panel, double-click on Regional
Settings, and then click on the Date tab.)

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

WORKAROUND
==========

Method 1. Define the value as it is defined in the Regional Settings.

Method 2. Modify the Regional Settings so that the Short Date Style and the
          Date Separator are defined using a hyphen separator instead of a
          slash separator.

KBCategory: kbenv
KBSubcategory:  kbtemplates
Additional reference words: 7.00 word95 custom properties property
regional settings date format hyphen slash type value name error
word7 message



Word 7.0: What is the "Tab as Indent" Feature?
Article ID: Q135293
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

Word 7.0 contains a new feature called Tab As Indent. This feature
provides a quick way to indent and unindent paragraphs by
automatically sensing when a tab character or a paragraph indent is
appropriate. To locate this feature, click Options on the Tools menu,
click the Edit tab, and then select or clear the "Use Tab and
Backspace Keys to set Left Indent" check box. This option is on by
default.

MORE INFORMATION
================

When you type text, the TAB and BACKSPACE keys function as they normally
do, that is, the TAB key will insert a tab character, and the BACKSPACE key
will delete the previous character. However, when you edit and reformat the
document, the TAB and BACKSPACE keys will apply indent paragraph formatting
in .5-inch increments.

For example, consider a document containing the following paragraph:

   Scotland: A constituent country of the United Kingdom comprising the
   northern part of the island of Great Britain and the Hebrides, Shetland
   Islands, and Orkney Islands. Inhabited by Picts in prehistoric times,
   the region was invaded but never conquered by the Romans and split into
   a variety of small kingdoms after the fifth century A.D.*

*The American Heritage Dictionary of the English Language, Third
Edition copyright 1992 by Houghton Mifflin Company. Electronic
version licensed from InfoSoft International, Inc. All rights
reserved.

If you have "Use Tab and Backspace Keys to set Left Indent" selected and
you press the TAB key before you type the text "Scotland: A
constituent...," the TAB key will act as it normally does--a tab character
is inserted at beginning of the paragraph.

However, if you first type the paragraph, then place the insertion point
before the first character in the paragraph, and press TAB, the TAB key
will insert a first-line indent. To remove the first-line indent, press the
BACKSPACE key.

To increase the left indent of the paragraph while maintaining the first-
line indent, type your paragraph, move the insertion point to the beginning
of the paragraph and press TAB two or more times. Each time you press TAB,
the paragraph is indented an additional .5 inch. When you press the
BACKSPACE key, the first-line indent is removed first. As you press the



BACKSPACE key additional times, you decrease the paragraph indentation.

To increase the left indent of the paragraph without increasing the first-
line indent, place your insertion point at the beginning of the second or
subsequent line on the left margin of the paragraph. To decrease the
indent, press the BACKSPACE key.

Remember, if you place the insertion point at the beginning of the first
line, you will get a first-line indent when you press the TAB key. If you
place the insertion point before the second or subsequent line in the
paragraph, you will get a left indent. When the paragraph contains a first
line indent, the BACKSPACE key removes the first line indent before it
decreases the left indent.

KBCategory: kbusage
KBSubcategory: kbformat
Additional reference words: 7.00 word95 tab as indent shift+tab backspace
increase decrease left first line indentation indenting indents unindent
word7 undent reduce



File Open: Can't Select Documents, Folders With Keyboard
Article ID: Q135294
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

You can not navigate through the Look In, File Name, or Files of Type
drop-down lists in the File Open dialog box by typing a letter on
your keyboard.  This functionality is different from previous
versions of Word which allowed you to quickly locate files or folders
that begin with a specific letter by typing that letter.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

WORKAROUND
==========

Use the mouse to navigate through the Look In, File Name, and Files
of Type lists.

KBCategory: kbusage
KBSubcategory:
Additional reference words: 7.00 word95 file open keyboard letter
word7 drop-down drop down list box navigate show



How to Enable, Disable Word as Your E-mail Editor in Exchange
Article ID: Q135295
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

Word for Windows 95 includes a component called WordMail that allows you to
create new Exchange messages using most of the features in Word. If you are
using Exchange as your e-mail client interface and have Word and the
WordMail component installed on your computer, you can use WordMail as your
e-mail editor.

MORE INFORMATION
================

The order of installation determines whether WordMail is enabled
automatically. If you installed Exchange before you installed Word for
Windows 95, WordMail is automatically enabled. If you installed Exchange
after you installed Word, WordMail is not enabled. To enable or disable
WordMail, do the following:

1. Start Exchange.
2. On the Compose menu, click WordMail Options.
3. Check or clear the "Enable Word as Email Editor" check box.
4. Click Close.

Disabling WordMail can be an important part of troubleshooting e-mail-
related problems. Testing an e-mail problem after you disable WordMail will
help you determine whether the problem is with Word or with the Exchange
client in general.

To run WordMail with adequate performance, 12 MB of RAM is recommended.

KBCategory: kbinterop
KBSubcategory:
Additional reference words: 7.00 word95 wordmail word mail email e-mail
word7 electronic mail



Odd Page Prints on Back of Odd Page with Postscript Driver
Article ID: Q135296
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you duplex print a document that is set up with odd and even
sections, the odd page will print on the back side of the previous
odd page if there is no even page. This behavior occurs when you
print to an HP LaserJet postscript printer using the Postscript
included with Windows 95.

STATUS
======

Microsoft has confirmed this to be a problem in the postscript
printer driver included with Windows 95. Microsoft is researching
this problem and will post new information here in the Microsoft
Knowledge Base as it becomes available.

WORKAROUND
==========

Use a non-postscript printer driver.

KBCategory: kbprint
KBSubcategory: kbprint
Additional reference words: 7.00 word95 print duplex double-sided
word7 two-sided both sides



"Microsoft Word Err=1078 - This file could not be found..."
Article ID: Q135297
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you run a macro that includes the ChDir WordBasic command, you get the
following error message

   Microsoft Word Err=1078
   This file could not be found <Filename>

where <Filename> represents the name of the document you are trying to
open.

CAUSE
=====

The following macro fails because the ChDir command does not recognize a
universal naming convention (UNC) path.

Sub Main
Chdir "\\Servername\Shared"
FileOpen "default.doc"
End Sub

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

RESOLUTION
==========

Use the following WordBasic macro to access the UNC path. You can then
change to the folder and select your file. The macro uses the Windows API
SetCurrentDirectoryA function to change the folder. Note: The
SetCurrentDirectoryA function name is case sensitive.

Declare Sub ChDirUNC Lib "kernel32" Alias "SetCurrentDirectoryA"(Path$)
Sub MAIN
S = ChDirUNC("\\servername\shared")
ChDir "\\servername\shared"
FileOpen "default.doc"
End Sub

WARNING: ANY USE BY YOU OF THE CODE PROVIDED IN THIS ARTICLE IS AT YOUR OWN
RISK. Microsoft provides this macro code "as is" without warranty of any
kind, either express or implied, including but not limited to the implied



warranties of merchantability and/or fitness for a particular purpose.

KBCategory: kbusage kberrmsg kbmacro buglist7.00
KBSubcategory: kbmacroexample
Additional reference words: 7.00 word95 macro change directory chdir
word7 wordbasic word basic
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SUMMARY
=======

This article contains the text of Application Note WD1216: "Word for
Windows 95 Frequently Asked Questions."

You can obtain this Application Note from the following sources:

 - CompuServe, GEnie, and Microsoft Partner Network (MSPN)
 - Microsoft Download Service (MSDL)
 - The Internet (Microsoft anonymous ftp server)
 - Microsoft FastTips Technical Library
 - Microsoft Product Support Services

For complete information, see the "To Obtain This Application Note" section
at the end of this article.

MORE INFORMATION
================

THE TEXT OF WD1216
==================
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Upgrading from Microsoft Word Version 6.0
------------------------------------------

1.  Q. In Microsoft Word 6.x, I imported data using ODBC. Why can't I
       do this anymore?

    A. Open Database Connectivity (ODBC) allows programs to import
       data from a variety of data sources. In earlier versions of
       Microsoft Word for Windows (versions 6.0, 6.0a, and 6.0c), the
       ODBC data files were included in the retail package. The
       Microsoft Word for Windows 95 stand-alone package does not
       include the ODBC files and drivers. If you want to import
       dBASE(R) or Microsoft FoxPro(R) data files, use the
       FoxPro/dBASE file converter. The FoxPro/dBASE converter is not
       installed during a typical setup. If you have stand-alone Word
       and want to install the FoxPro/dBASE converter, follow these
       steps:

       1. Start Microsoft Word Setup.
       2. Click Add/Remove.
       3. Highlight Converters and Filters.
       4. Click Change Option.
       5. Highlight Converters.
       6. Click Change Option.
       7. In the Options list, select the FoxPro/dBASE Converter check
          box.
       8. Click OK to close the Converters dialog box, and then click
          OK again.
       9. Click Continue to start installing the files.

       You can use other methods to import data. First, many programs
       support the DDE method of data sharing. If Microsoft Access or
       Microsoft Excel is loaded properly on the same computer as
       Word, you can use the DDE method to import data. Second, there
       may be a specific text converter for the data. FoxPro/dBASE,
       Microsoft Excel, and WordPerfect are examples of data formats
       that have a text converter included with Microsoft Word for
       Windows 95. When you use the Insert Database or the Mail Merge
       Open Data Source dialog boxes, you see a box labeled Select
       Method. If this box is selected, Microsoft Word for Windows 95
       displays a list of the available conversion methods (ODBC, DDE,
       Converter) from which you can select the method you want to
       use.

2.  Q. I purchased the Microsoft Word stand-alone package, which does
       not include the ODBC files and drivers. Can I obtain the ODBC
       files and drivers without having to purchase another retail



       package?

    A. Microsoft will make the ODBC files and drivers available, at no
       cost, as an Application Note in the fall of 1995. The
       Application Note number is WD1198 and is titled "ODBC Add-in."

       When this Application Note is available, you can obtain it from
       the following sources:

        - MSN, The Microsoft Network
        - The Microsoft Partner Network (MSPN)
        - CompuServe(R) and GEnie(TM)
        - The Microsoft Download Service (MSDL)
        - The Internet (Microsoft anonymous ftp server)
        - Microsoft FastTips Technical Library, (800) 936-4100
        - Microsoft Product Support Services, (206) 462-9673

       (ODBC is included in the Microsoft Office for Windows 95 retail
       package and with the stand-alone Microsoft Access retail
       package, scheduled to ship in the fall of 1995.)

3.  Q. Why do I receive error messages such as "Unable to open
       specified library," and why don't my old add-ins, such as
       Internet Assistant and Word Assistant, work with Microsoft Word
       for Windows 95?

    A. Microsoft Word for Windows 95 is a 32-bit word processing
       program. While this design allows Word for Windows 95 to take
       advantage of advanced features in Windows 95, it creates
       compatibility problems with 16-bit components.

       When you receive the "Unable to open specified library" or
       "Word cannot load this add-in" error message, it means that
       Word is trying to gain access to a 16-bit library (a DLL or WLL
       file) and is unsuccessful. Any macro that uses Declare
       statements to gain access to Windows API functions may also
       encounter this problem.

        - To resolve this problem in macros, modify the macros to call
          the appropriate 32-bit version of the Windows API functions,
          or contact the author of the macro for an updated version.

        - To resolve this problem in add-ins, obtain updated 32-bit
          versions of the add-ins.

       Other common macros that may generate WordBasic errors in
       Microsoft Word for Windows 95 are FileOpen, FileSave, and
       FileSaveAs. These macros may make invalid 16-bit API calls, as
       described above, or they may not be written to handle long
       filenames properly.

       To temporarily work around these issues, do the following:

        - Remove any templates or add-ins from the Word Startup
          folder.

        - Use the Organizer, which is located in the (Tools) Options



          dialog box, to temporarily rename any FileOpen, FileSave, or
          FileSaveAs macros to names such as FileOpenOld, FileSaveOld,
          and FileSaveAsOld.

       For more information about these issues, click Answer Wizard on
       the Help menu, click the Find tab, enter "582" (without the
       quotation marks) in the first box, and then click Display.

4.  Q. I want my macros to use the new (File) Open and Advanced Find
       dialog boxes; why do some of my Microsoft Word 6.0 for Windows
       macros that use Open and File Find dialog boxes not work
       correctly in Microsoft Word for Windows 95?

    A. The Microsoft Word for Windows 95 Open dialog box is
       considerably more complex than the Open dialog box in Microsoft
       Word 6.0. Also, Word for Windows 95 does not contain a File
       Find dialog box. The new Open dialog box incorporates the Find
       feature (which is a separate command in Word 6.0) and offers an
       expanded option set.

       Even though the functionality has changed, some of your Word
       6.0 FileOpen and FileFind statements work correctly in Word for
       Windows 95. However, because many of the arguments are new or
       work differently, you may have to edit some of your Word 6.0
       macros that contain FileOpen or FileFind statements so that
       they work correctly in Word for Windows 95. For information
       about the new FileOpen and FileFind statements and how to use
       them correctly, refer to the WordBasic Reference in Microsoft
       Word Help.

       Because of the changes to the File commands in Word for Windows
       95, the Word 6.0 FindFile statement functions quite differently
       in Word for Windows 95. In Word for Windows 95, the following
       arguments are ignored, and you cannot use a Dialog or Dialog()
       instruction to display the Word 6.0 Find File dialog box:

          .SearchName
          .Options
          .PatternMatch
          .View
          .SortBy
          .ListBy
          .SelectedFile
          .ShowFolders
          .Add
          .Delete

       Instead, the Open dialog box is displayed. Furthermore, if you
       select a file in the Open dialog box, the file does not
       actually open because the .SelectedFile argument does not
       function.

       If your Word 6.0 macro uses a Find File dialog box, you need to
       redesign the macro to use a custom dialog box. You can use the
       FindFile statement to return a list of found files and then
       display the list in a custom dialog box. The example for the
       FindFile statement in WordBasic Help shows you how to fill an



       array with a list of found files. If you are not familiar with
       creating custom dialog boxes, consult WordBasic Help or the
       "Microsoft Word Developer's Kit" for more information.

5.  Q. What happened to WordArt, the Grammar Checker, and the dBASE
       converter?

    A. WordArt, the Grammar Checker, and the dBASE converter are not
       installed in a typical setup of Microsoft Word for Windows 95.
       In earlier versions of Microsoft Word, these options were part
       of the Typical Setup option.

       To install WordArt, the Grammar Checker, and the dBASE
       converter, you need to run the Maintenance Setup program for
       Office. To start the Maintenance Setup program, locate the
       Office folder and double-click the Setup icon. On the first
       Setup screen, click Add/Remove, and then continue with the
       appropriate steps below.

       To install WordArt, follow these steps:

       1. Click Office Tools.
       2. Click Change Option.
       3. In the Options list, select the WordArt check box.
       4. Click OK, and then click Continue.

       To install the Grammar Checker, follow these steps:

       1. Click Microsoft Word.
       2. Click Change Option.
       3. In the Options list, click Proofing Tools.
       4. Click Change Option.
       5. In the Options list, select the Grammar check box.
       6. Click OK, and then click Continue.

       To Install the dBASE converter, follow these steps:

       1. Click Converters, Filters, And Data Access.
       2. Click Change Option.
       3. In the Option list, click Data Access.
       4. Click Change Option.
       5. In the Options list, select the "dBASE and Microsoft FoxPro
          Drivers" check box.
       6. Click OK, and then click Continue.

       To install all components for Microsoft Word that were not
       installed with a Typical Installation of Office 95, follow
       these steps:

       1. Click Microsoft Word.
       2. Click Change Option.
       3. Click Select All.
       4. Click OK, and then click Continue.

6.  Q. I am having trouble getting used to the new (File) Open
       dialog box. Are there tips that will make the transition
       easier?



    A. One tip is to make sure that the new Open dialog box advanced
       option Search Subfolders is not checked. When you use Search
       Subfolders, you can query for specific files based on certain
       criteria including filename, content, title, author, size, and
       creation date. While using the Search Subfolders option is
       useful for locating files in unknown subfolders, it slows down
       and affects the display of files in day-to-day File Open usage.
       To clear this option, click Advanced and clear the Search
       Subfolders check box.

       Another tip is to use the My Favorites folder to make retrieval
       of important or often-used documents easier. You may want to
       create shortcuts to documents here for frequent retrieval,
       especially if the documents are located in a folder other than
       the default folder.

       A final tip is to learn the benefits of each of the views (see
       the List, Details, Properties, and Preview buttons at the top
       of the Open dialog box), and to use them appropriately. By
       using the views appropriately, you can customize the Open
       dialog box to make opening files more convenient and efficient.

        - When you select the List button, the filenames contained in
          the specified folder are displayed. The files are listed in
          columns, from left to right.

        - When you select the Details button, more information about
          the file (the filename, file size, file type, and date the
          file was last modified) is displayed. The files are listed
          from top to bottom.

        - When you select the Properties button, a two-paned window is
          displayed that shows the filenames and folder tree in the
          left pane and the document statistics and summary
          information for the selected file in the right pane.

        - When you select the Preview button, a two-paned window is
          displayed that lists the filenames and directory tree in the
          left pane and a preview of the selected file in the right
          pane. For more information about Preview view, see question
          3, "Why do previews take so long to appear in the (File)
          Open dialog box?" in the "Using Microsoft Word for Windows
          95" section below.

7.  Q. What does the tab for "Shortcut to Old Templates" mean in my
       (File) New dialog box?

    A. If there is a tab in the New dialog box labeled "Shortcut to
       Old Templates," Microsoft Word for Windows 95 has created a
       shortcut to the template location of the old version of
       Microsoft Word. For example, version 6.0 of Word was probably
       installed in a folder called C:\Winword, and user templates
       were probably stored in the C:\Winword\Template folder. Because
       Word for Windows 95 uses the MSOffice\Templates folder by
       default, a special tab is needed to make the previous templates
       available. Remember that this tab represents a shortcut to the



       old templates, and you should be cautious when you delete files
       from the old C:\Winword\Template folder. If you delete the
       actual templates from C:\Winword\Template, the Shortcut tab in
       the New dialog box will not appear because it points to an
       empty folder.

       The reason Word 6.0 templates are not copied or moved to your
       MSOffice\Templates directory is to save disk space and to allow
       macros that depend on the Word 6.0 folder structure to work in
       Word for Windows 95.

       To completely eliminate the C:\Winword\Template folder from
       your computer, move or copy all of the .dot files from
       C:\Winword\Template to the MSOffice\Templates folder or to a
       subfolder of this folder.

8.  Q. What do I need to do to convert my Microsoft Word 6.x
       documents into Microsoft Word for Windows 95 documents?

    A. The Microsoft Word for Windows 95 file format is fully
       compatible with the Microsoft Word 6.x feature set. This means
       you can open Word 6.x documents in Word for Windows 95
       automatically and open Word for Windows 95 documents
       automatically in Word 6.x. Note that in this case, features
       that are available only in Word for Windows 95, such as the
       highlighted text feature, will not be available in Word 6.x.

Using Microsoft Word for Windows 95
-----------------------------------

1.  Q. Why do I receive an "Out of Memory" error message when I
       try to start Microsoft Word for Windows 95?

    A. An "Out of Memory" error message may be caused by several
       settings on your computer. Sometimes the problem is not even
       directly related to memory. Unusual printer drivers, high-
       resolution video drivers, and add-in programs may cause this
       error message to appear.

       To ensure that you have enough memory, first check the disk
       space. If you have less than 10 megabytes (MB) of disk space,
       free up a few megabytes. Depending on the complexity of your
       installation and the way you use your system, it may take
       approximately 10 MB of free disk space to start any of the
       Office programs. This requirement is necessary because of the
       way Windows 95 manages and presents memory to the programs.

       Next, check to see if you need to change your virtual memory
       settings. Windows 95 uses virtual memory (free space on your
       hard disk) to allocate programs more memory than your amount of
       physical RAM. The amount of hard disk space used as virtual
       memory adjusts dynamically, based on the current program's
       requirements and the amount of free space available. If you
       used a permanent setting for virtual memory (called a permanent
       swap file) in Windows 3.1, you may want to change it to a
       dynamic swap file in Windows 95. This allows for more efficient
       allocation of resources and helps prevent unwarranted "Out of



       Memory" error messages. To check your virtual memory settings
       and to change them if necessary, follow these steps:

       1. Click the Start button, point to Settings, and then click
          Control Panel on the menu that appears.

       2. In Control Panel, double-click the System icon.

       3. In the System Properties dialog box, click the Performance
          tab, and then click Virtual Memory.

       4. In the Virtual Memory dialog box, click "Let Windows manage
          my virtual memory settings (recommended)," and then click
          OK.

       5. Confirm the "Restart Your Computer'' message if it is
          displayed.

       Finally, use the following methods if you need to free up more
       hard disk space:

        - Empty the Recycle Bin.

        - Delete old files in your temporary file folder. To locate
          the temporary file folder and to delete the old files,
          follow these steps:

          1. From any Office program, click Help, and then click About
             <Office Program Name> on the menu that appears.

          2. In the About <Office Program Name> dialog box, click
             System Info.

          3. In the Microsoft System dialog box, note your temporary
             file folder. The temporary file folder is the last item
             listed, and it is usually set to C:\Windows\Temp.
             However, it can be set to another folder.

          4. Close the Microsoft System dialog box, and then quit all
             Office programs that you have open.

          5. Open Windows Explorer and click the Temp folder.

          6. You can safely delete any file that starts with a tilde
             (~) character and is dated earlier than the current date.

          7. Also look for old e-mail attachments or other temporary
             files that you can delete.

        - Remove programs or parts of programs that you do not use.
          For example, you can remove components of Windows or Windows-
          based programs by using the Add/Remove Programs option in
          Control Panel.

       If you determine that disk space is not a factor, check the
       printer driver and video driver by changing them to common
       settings. For example, set the video resolution to 16 color,



       640 x 480 mode, and change the default printer to an HP
       LaserJet IV.

       Other common causes for "Out of Memory" error messages at
       startup are system related. For more information about how to
       troubleshoot these problems, see the answer to the next
       question.

2.  Q. Why do I receive a general protection fault when I start
       Microsoft Word for Windows 95?

    A. There are a number of reasons why you may receive a general
       protection (GP) fault when you start Microsoft Word for Windows
       95. One reason may be that the shared Office AutoCorrect list
       file has become damaged.

       If the file, generally called <Logonname>000.acl (where
       <Logonname> is the name you use to log on), is damaged, a GP
       fault may occur when you start Word. To correct this problem,
       locate the .acl file and rename the file so that Word does not
       try to load it at startup. For example, rename the file
       Autocorrect.old. Because the file no longer has an .acl
       extension, Word does not load the file when it starts. The
       steps below show how to determine if a corrupt AutoCorrect list
       is the problem. Because the steps include renaming the file,
       the AutoCorrect entries can be made available if it turns out
       that the AutoCorrect list was not the source of the problem.

       To locate and rename the .acl file, follow these steps:

       1. Click the Start button, point to Find, and click Files And
          Folders.

       2. In the Find: All Files dialog box, enter "*.acl" (without the
          quotation marks) in the Named box.

       3. In the Look In box, enter "c:\" (without the quotation marks),
          select the Include Subfolders check box, and then click Find Now.

       4. Select the <Logonname>000.acl file (where <Logonname>is the
          name you use to log on), and then press the F2 key.

       5. Rename the file <Logonname>.bad, and then press ENTER.

       Other settings, such as the default printer driver, the
       Normal.dot template, and the video driver properties may also
       cause this problem. The next step in troubleshooting is to
       change those properties. For example, change the printer driver
       to a new, different driver, change the video settings to 16
       color, 640 x 480 mode, and rename the Normal.dot file
       Normal.old.

       To change the default printer driver, follow these steps:

       1. Click the Start button, point to Settings, and then click
          Printers.



       2. In the Printers window, use the right mouse button to click
          a printer that is not the default printer, and on the menu
          that appears click Set As Default.

       To change the video settings, follow these steps:

       1. Click the Start button, point to Settings, and then click
          Control Panel.

       2. In Control Panel, double-click the Display icon.

       3. In the Display Properties dialog box, click the Settings
          tab.

       4. Under Color Palette, select the 16 Color option.

       5. Under Desktop, slide the indicator to the left until it
          registers 640 by 480 pixels, and then click OK.

       To rename the Normal.dot file, follow these steps:

       1. Click the Start button, point to Find, and click Files And
          Folders.

       2. In the Find: All Files dialog box, enter "normal.dot" (without
          the quotation marks) in the Named box.

       3. In the Look In box, enter "c:\" (without the quotation marks),
          select the Include Subfolders check box, and then click Find Now.

       4. Select the Normal.dot file, and then press the F2 key.

       5. Rename the file Normal.old, and then press ENTER.

3.  Q. Why do previews take so long to appear in the (File) Open
       dialog box?

    A. When you select a document in the Name list of the Open dialog
       box when the Preview button is selected, Microsoft Word
       presents a preview of the document in the box to the right.
       There are two preview types: "full preview" and "thumbnail."

       If the hourglass appears and it seems to take a long time
       before the preview appears, Microsoft Word is actually opening
       the document to show the preview. This type of preview is
       called "full preview," and performance is even slower if the
       document selected in the Name box is located on a network
       server.

       A "thumbnail" preview, which is like a snapshot of the
       document's first page, is quicker than full preview because a
       thumbnail is an OLE object. If you want your document to appear
       as a thumbnail preview in the Preview box instead of as a full
       preview, click Properties on the File menu while the document
       is open, click the Summary tab, and select the Save Preview
       Picture check box. Note that this property is specific to the
       document; selecting this property does not change all previews



       to thumbnail previews.

       To work around this problem in general, select one of the other
       views besides Preview in the Open dialog box.

       To ensure the fastest preview possible, make sure the Save
       Picture Preview check box is selected in the (File) Properties
       dialog box. If the Prompt For Document Properties check box is
       selected on the Save tab of the (Tools) Options dialog box,
       then when you initially save a new document, save an existing
       document to a new location, or rename an existing document, the
       Properties dialog box appears, allowing you to select or clear
       the Save Picture Preview check box. The last setting for the
       Save Picture Preview option will be retained when the
       Properties dialog box reappears. In the event that the Prompt
       For Document Properties check box is cleared, be sure to select
       the Save Picture Preview check box to avoid unwanted delays
       when using the Preview button in the Open dialog box. Again,
       the last setting will be retained as the default selection.

       NOTE: Using the Save Picture Preview option may increase the
       file size. The increase is typically negligible and varies
       depending on the size of the document.

4.  Q. Why do I receive messages about "corrupt" documents from the
       Find Fast application?

    A. The Find Fast application works in the background to index
       Office documents so that document retrieval is faster. If Find
       Fast encounters a damaged document during the indexing, it
       reports the damaged document. To stop the warning message from
       appearing, remove the problem document from the indexed drive.
       It is important to note that Find Fast does not cause the
       problem; the problem already exists, and Find Fast just reports
       it. Therefore, focus your troubleshooting on cleaning up the
       bad document instead of looking for a problem with Find Fast.

       The Office Setup program installs Find Fast in the Windows 95
       Startup folder so that all Office documents are indexed
       automatically at system startup and periodically at two-hour
       intervals. Find Fast must be able to gain access to document
       contents to successfully complete the indexing process. Find
       Fast may stop and display the following error message when it
       attempts to open and index a damaged Microsoft Word document:

          Error: Find Fast could not index the file "C:\My
          Documents\Test.doc." To restart Find Fast, remove the file,
          and then double-click the Find Fast icon in the Windows
          Control Panel.

       To resolve the problem, remove or correct the damaged document,
       and then restart Find Fast.

5.  Q. I am using Microsoft Word as my e-mail editor in Microsoft
       Exchange. Sometimes it seems like my computer switches back and
       forth between Word and the Exchange Inbox. Also, how do I
       disable Word as my e-mail editor?



    A. When you use Microsoft Word as your e-mail editor, a "hidden"
       instance of Word is loaded into the computer's memory. Even
       though it seems that there are two separate programs running
       (Word as an e-mail editor and Word itself), they are really the
       same instance of Word. This can lead to unusual responses from
       Word in some cases. These "one instance" issues may manifest
       themselves in several ways. For example, if you are in Word and
       you click Open on the File menu and then try to switch to "New
       Message--Microsoft Word" (that is, WordMail), the Open dialog
       box still maintains the focus. You must dismiss the dialog box
       before switching to WordMail.

       To disable Word as your e-mail editor, click WordMail Options
       on the Compose menu in Exchange, and clear the "Enable Word as
       Email Editor" check box.

       Other functionality that may not work as expected when you use
       Word as your e-mail editor includes:

        - The Record, Create, and Edit buttons are unavailable
          (dimmed) when you try to create a macro in WordMail. The
          only options available are Run and Delete after you select
          an existing macro.

        - Text in the Subject line is not handled by Word. Therefore,
          spell checking, AutoCorrect, and undo/redo are not available
          in the Subject line.

        - You cannot gain access to many of the toolbars in Word (and
          some general menu commands) while the insertion point is in
          any of the header wells (such as To:, From:, and so on).

        - The Exchange editor has buttons for high priority, low
          priority, read receipt, and so on. In WordMail, all of this
          functionality exists, but you must use the Properties button
          on the toolbar, the Properties command on the File menu, or
          press ALT+ENTER to gain access to this functionality.

        - The Exchange editor has commands and options that are
          different in WordMail. For example, in WordMail, the Next
          and Previous commands appear on the File menu, and Show-Bcc
          is toggled with a check box in the Properties dialog box.

        - The shortcut key (accelerator) for "To:" works only when the
          insertion point is in the header.

        - There is no support for "Send on behalf of;" otherwise known
          as the From field.

        - There is no Print Preview command in WordMail. In WordMail,
          Page Layout view can be used for most of this functionality.

        - There are many shortcut keys (accelerators) in the Exchange
          editor that conflict with the shortcut keys in Microsoft
          Word. Email.dot contains the following shortcut keys so that
          you can still perform the same actions:



          Function      Exchange editor          WordMail
                        shortcut keys            shortcut keys
          ----------------------------------------------------

          Delete        CTRL+D                   CTRL+D
          Message
          Forward       CTRL+F                   CTRL+SHIFT+F
          Next          CTRL+> OR CTRL+. or      CTRL+SHIFT+N
                        CTRL+SHIFT+N
          Previous      CTRL+< OR CTRL+, OR      CTRL+SHIFT+P
                        CTRL+SHIFT+P
          Properties    ALT+ENTER                ALT+ENTER
          Address Book  CTRL+SHIFT+B             CTRL+SHIFT+B
          Reply to      CTRL+R                   CTRL+R
          sender
          Reply to all  CTRL+SHIFT+R             CTRL+SHIFT+R

          To create your own template to use with WordMail, make a
          copy of Email.dot. Give the new file a different name, and
          make your changes in the new file. By copying Email.dot, you
          carry over the shortcut keys and their associated macros.
          This also ensures that the four message header styles (which
          are applied to forwarded messages and printed messages) are
          appropriately named in the new template.

6.  Q. I get unwanted results from AutoCorrect and AutoFormat as I
       type. For example, if I begin a paragraph with "F. John Doe,"
       Microsoft Word tries to automatically number the paragraph
       after I press ENTER. How can I avoid these results without
       disabling AutoCorrect and AutoFormat?

    A. AutoCorrect and AutoFormat use internal algorithms to
       intelligently guess at the correct times to adjust text. These
       algorithms can lead to unwanted corrections in some cases.

       To prevent Microsoft Word from automatically numbering a
       paragraph that begins with a first-name initial, click
       AutoFormat on the Format menu, click Options, select AutoFormat
       As You Type, and clear the Automatic Numbered Lists check box.
       (You can toggle other AutoFormat options on or off as well.)
       Click OK, and then click Cancel.

       To avoid incorrect AutoCorrect assumptions involving
       capitalization, create an AutoCorrect exception. On the Tools
       menu, click AutoCorrect, and then click Exceptions. Make the
       appropriate entry, click OK, and then click OK again.

       You can also automatically format other items, such as when to
       use heading styles, and when to replace "Straight Quotes" with
       "Smart Quotes."

7.  Q. Sometimes pressing the TAB key does not insert a tab character
       on the screen. Instead my text is adjusted to the left by a
       small amount. What is happening?

    A. Microsoft Word for Windows 95 includes an editing feature



       called Tab As Indent. Usability testing shows that when the
       desired result is actually an indented line or paragraph, many
       users start by pressing the TAB key. When you have Tab As
       Indent turned on, Word tries to intelligently guess when an
       actual tab is desired and inserts a tab character in those
       situations, but Word may not guess correctly all the time. You
       can disable the Tab As Indent feature by clicking Options on
       the Tools menu, clicking the Edit tab, and clearing the "Use
       Tab and Backspace Keys to set Left Indent" check box.

       When this feature is turned on, pressing the TAB key while the
       insertion point is at the left side of a second or greater line
       in a paragraph results in the paragraph being indented by .5
       inch from the left margin. Pressing the BACKSPACE key at this
       point would then move the paragraph back to the original
       margin. To enter a tab character instead of apply an indent,
       press CTRL+TAB.

8.  Q. I am not getting the answers that I need from the Answer
       Wizard. What can I do?

    A. The key to getting the best results from the Answer Wizard is
       to phrase your request with the best combination of keywords.
       Your request should uniquely describe your topic but exclude
       extraneous information. For example, if you want help with
       headers and footers, make sure you use the word "header"
       specifically, because the word "header" would not be used in
       any other topic. Be sure to read the list of suggested topics.
       Often the content of a topic is more meaningful than the title
       indicates.

       You may also want to use the Contents, Index, and Find tabs in
       Help. Each of these methods is helpful in finding information.

       Additional Tips for Using the Answer Wizard

        - Use two or more words in the question. For instance, if you
          type "tabs?", you will receive a different answer than if
          you type "tabs in tables?"

        - Avoid noise words. Noise words are common words that may be
          present in many of the topics and only confuse the search by
          offering too many alternatives. If you are not getting the
          correct results, remove the noise words from your question.
          Noise words include "put," "make," "start," and "get."

        - Check your spelling. The Answer Wizard cannot interpret
          misspelled words.

        - If the Answer Wizard finds more than seven "How Do I" or
          five "Tell Me About" topics, you will be asked to rephrase
          the question. Use some of the above tips to rephrase your
          question.

        - Browse the results of your search; a title may provide cross
          references to other subjects or to additional information
          that would also be helpful.



       About the Answer Wizard

       The Help engine in Windows 95 displays a three-tab dialog box;
       these tabs include Contents, Index, and Find (similar to Search
       in earlier versions of Help). Microsoft Office for Windows 95
       programs include a fourth tab called the Answer Wizard. The
       Answer Wizard uses natural-language questions to locate
       information about tasks and features that is stored in a
       database of common terminology.

       Topic Areas

       After the Answer Wizard searches on a question, it displays
       either two or three categories under "2. Select a topic, and
       then click Display."

       Category     Description
       ------------------------------------------------------------

       How Do I?    When you type in a simple question such as "How
                    do I bold text?", the Answer Wizard searches
                    for references to applying bold formatting.
                    When the database search is complete, the
                    Answer Wizard returns any "how to" entries
                    relating to bolding text, as well as "Tell Me
                    About" and "Programming" information. If there
                    are more than a few entries relating to how to
                    bold text, the Answer Wizard warns that you
                    should rephrase the question.

                    In some cases, the Answer Wizard shows how to
                    accomplish a task. For instance, if you ask the
                    Answer Wizard "How do I bold text?", the first
                    item returned under "How Do I" may be "Change
                    text and numbers to bold." If you select this
                    item and click Display, Microsoft Word is
                    brought forward, and the Answer Wizard steps
                    you through the formatting process using the
                    Bold button on the Formatting toolbar.

       Tell Me      In addition to how-to instructions, the Answer
       About        Wizard database is cross-referenced with
                    informational cards and tips. For example, if
                    bold formatting is the topic and you would like
                    to know more about character formatting, select
                    "Character formatting" under Tell Me About.

       Programming  The Programming section may or may not appear,
                    depending on the question. If there is any
                    reference for accomplishing the task
                    programmatically, the Answer Wizard may offer
                    information in this section. Displaying a topic
                    in this section opens the Programming Reference
                    for the appropriate product.

9.  Q. Does Microsoft Word for Windows 95 include Visual Basic(R) for



       Applications?

    A. Microsoft Word for Windows 95 does not include Visual Basic for
       Applications. WordBasic, which is the current macro language,
       has been expanded to take advantage of the new feature set.
       Microsoft Word can still be used as an OLE automation server
       and provide information to other programs that use Visual Basic
       for Applications.

Printing
--------

1.  Q. When I click the Properties button in the Print dialog box,
       either I get a general protection fault, or the button just
       does not work. What causes this and how can I correct it?

    A. This is a known issue for Microsoft Word for Windows 95 and
       occurs when the name of the printer either contains the word
       "on" or ends with ")" (a closing parenthesis character ). If
       you are running Microsoft Word for Windows 95 with Windows NT
       3.51, the result is a general protection (GP) fault. If you are
       using Windows 95, the Properties button does not trigger any
       action.

       To work around this problem, rename the printer so that the
       name does not include the word "on" or end with the ")"
       character. To rename the printer in Windows NT 3.51, use the
       Print Manager icon in the Main group. To rename the printer in
       Windows 95, click the Start menu, point to Settings, click
       Printers, click the printer name, and type the new name.

       Note that if you are changing the printer name in Windows NT
       3.51, you must perform these steps on the server to which the
       printer is attached unless you have chosen to copy the printer
       driver to the local workstation. Windows NT defaults to using
       the printer driver from the server. If the printer driver is on
       the server, you can only change the printer name on the server.

2.  Q. Why do my EPS graphics print in lower resolution in Microsoft
       Word for Windows 95 than in Microsoft Word 6.x?

    A. The encapsulated PostScript(TM) (EPS) graphics filter that ships
       with Microsoft Word for Windows 95 contains a problem that
       causes some EPS graphics to print incorrectly. Most EPS
       graphics consist of two components: the PostScript code, which
       tells the printer what to print, and a bitmapped header, which
       provides a screen preview. Microsoft Word 6.x correctly prints
       only the PostScript code, whereas Microsoft Word for Windows 95
       incorrectly prints both the PostScript code and the bitmapped
       header. If the bitmapped header is a low-resolution image
       (which it commonly is), the resulting printout has a low
       resolution. You can work around this problem if the program
       that created the EPS graphic file has the option to not include
       the bitmapped header in the file. When the bitmapped header is
       not present, Microsoft Word can print the image in a higher
       resolution.



       More specifically, an EPS graphics file is a standard
       PostScript language file with an optional bitmap screen preview
       included in the format. An EPS file is generally included as an
       illustration in other documents, such as a Microsoft Word
       document. If an EPS file contains an embedded TIFF or WMF
       display image, a representation of the image is displayed in
       Microsoft Word for Windows 95. The quality of the display image
       depends on the resolution of the TIFF or WMF image embedded in
       the EPS file. Because such display images are intended
       primarily as positioning aids in page composition, their
       resolution is often low.

       When you print to a PostScript printer, the PostScript commands
       should be the only information from the PostScript section of
       the file sent to the printer, regardless of whether a TIFF or
       WMF display image is embedded in the EPS file. The on-screen
       resolution of the display image should not have an effect on
       the printing quality of the document. However, because
       Microsoft Word for Windows 95 incorrectly prints the screen
       preview in addition to the PostScript code, the print quality
       is affected.

       When you print to a non-PostScript printer and a TIFF or WMF
       display image is embedded in the EPS file, Word for Windows 95
       incorrectly prints the TIFF or WMF image. As indicated above,
       such images are normally of low resolution (for example, 128 x
       128 bits), and therefore, the resolution of the printed image
       is relatively low. If a document contains an EPS file without
       an embedded TIFF or WMF display image, or if the image is
       considered invalid by the converter, only a bounding box is
       printed on a non-PostScript printer. This behavior is normal
       because EPS graphics are designed to print only to PostScript
       printers.

3.  Q. Are there any plans to change the EPS printing behavior in
       Microsoft Word for Windows 95?

    A. Microsoft will soon have available an Application Note with a
       correction for the EPS printing problem. The Application Note
       number is WC1199 and is titled "EPS Filter." When the
       Application Note is available, you can obtain it from the
       following sources:

        - MSN, the Microsoft Network
        - The Microsoft Partner Network (MSPN)
        - CompuServe and GEnie
        - The Microsoft Download Service (MSDL)
        - The Internet (Microsoft anonymous ftp server)
        - Microsoft FastTips Technical Library, (800) 936-4100
        - Microsoft Product Support Services, (206) 462-9673

--------------------------------------------------------------------------

TO OBTAIN THIS APPLICATION NOTE
===============================



 - On CompuServe, GEnie, and Microsoft Partner Network (MSPN), Application
   Notes are located in the Microsoft Software Library. You can find WD1216
   in the Software Library by searching on the word WD1216, the Q number of
   this article, or S15510. WD1216.exe is a compressed, self-extracting
   file. After you download WD1216.exe, double-click it to extract the
   contents of the file.

 - Application Notes are available by modem from the Microsoft Download
   Service (MSDL), which you can reach by calling (206) 936-6735. This
   service is available 24 hours a day, 7 days a week. The highest download
   speed available is 14,400 bits per second (bps). For more information
   about using the MSDL, call (800) 936-4100 and follow the prompts. To
   obtain WD1216, download WD1216.exe. WD1216.exe is a compressed, self-
   extracting file. After you download WD1216.exe, double-click it to
   extract the contents of the file.

 - On the Internet, Application Notes are located on the Microsoft
   anonymous ftp server, which you can reach by typing the following at the
   ">" prompt:

      ftp ftp.microsoft.com

   To download WD1216.exe, change to the Softlib/Mslfiles directory and
   type the following at the ">" prompt:

      Get WD1216.exe

 - You can have this Application Note mailed or faxed to you from the
   automated Microsoft FastTips Technical Library, which you can call 24
   hours a day, 7 days a week at (800) 936-4100. NOTE: The FastTips
   Technical Library is available only to customers within the U.S. and
   Canada.

 - If you are unable to access the sources listed above, you can have
   this Application Note mailed or faxed to you by calling Microsoft
   Product Support Services Monday through Friday, 6:00 A.M. to 6:00 P.M.
   Pacific time at (206) 462-9673. If you are outside the United States,
   contact the Microsoft subsidiary for your area. To locate your
   subsidiary, call the Microsoft International Sales Information Center at
   (206) 936-8661.
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FileFind Macro Doesn't Allow You to Open Selected Document
Article ID: Q135590
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

The Open button does not open the selected file after you run a
WordBasic macro using the FileFind command; instead; it closes the
Find File dialog box.  To demonstrate this behavior, run the
following macro:

Sub MAIN
Dim dlg As FileFind
GetCurValues dlg
dlg.SearchPath = "c:\my documents"
dlg.Name = "*.doc"
x = Dialog(dlg)
FileFind dlg
End Sub

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

WORKAROUND
==========

Since the FileFind command will not allow you to open a document,
create another macro that runs the FileOpen command and specify the
name of the file you want to open.
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Red Squiggly Line Appears in Callout Box
Article ID: Q135591
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When Automatic Spell Checking is on and the first word in the first
callout you inserted in your document is misspelled, a red squiggly
underline appears in subsequent, empty callouts that you add to your
document. (The red squiggly underline is used by Word's Automatic
Spell Checking feature to identify misspelled words.)  This behavior
occurs in Word documents and when you compose notes using WordMail.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

WORKAROUND
==========

The red squiggly line will disappear when you type a character or
press the space bar in the callout.
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Macro Example: Find Field and Change to Text in Header/Footer
Article ID: Q136068
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

The macro example below demonstrates how to search for a particular field
and unlink the field result to normal text.

MORE INFORMATION
================

This macro example opens a new document, opens the footer, and inserts the
field Filename. It then finds the Filename field and unlinks the field
result to normal text.

WARNING: ANY USE BY YOU OF THE OR MACRO CODE PROVIDED IN THIS ARTICLE IS AT
YOUR OWN RISK. Microsoft provides this macro code "as is" without warranty
of any kind, either express or implied, including but not limited to the
implied warranties of merchantability and/or fitness for a particular
purpose.

Sub Main
     ScreenUpdating 0
     FileNewDefault
     ViewFooter
     InsertField .Field = "filename"
     StartOfWindow
     EndOfWindow 1
     ToggleFieldDisplay
     EditFind .Find = "^d filename", .Wrap = 0
     If EditFindFound() Then UnlinkFields
     ToggleFieldDisplay
     CloseViewHeaderFooter
     ScreenUpdating 1
End Sub

KBCategory: kbusage kbmacro
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Error When Starting Word Art Using Insert Object Command
Article ID: Q136215
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you use the Object command on the Insert menu to activate Microsoft
Word Art 2.0, you receive the following error message:

   The server application, source file, or item cannot be found. Make
   sure the application is properly installed, and that it has not been
   deleted, moved, or renamed.

CAUSE
=====

This problem occurs when you try to register Word Art 2.0 by double-
clicking the Wordart2.reg file. The Wordart2.reg file contains an error
that points all references to Word Art in the Windows Registry to
C:\Windows\Msapps, regardless of what folder Word Art is installed in.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95,
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Use Windows Explorer to open the Program Files\Common Files\Microsoft
Shared\WordArt folder, and double-click Wrdart32.exe to correctly register
WordArt. The following message will appear:

   Wordart may only be used to embed objects.  It must be started from
   within another application.

Click OK, and return to Word. WordArt is now registered correctly.

If the WordArt folder is absent, run Setup again to reinstall Word Art 2.0.

KBCategory: kbtool kberrmsg
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Documents Created from Desktop Don't Reflect Normal Template
Article ID: Q136216
--------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------

SYMPTOMS
========

Word documents created by clicking the Desktop in Windows 95 do not
reflect fonts or other settings stored in the Normal template.

However, changing the default font while in such a document changes both
the default document that appears when you create a document in this manner
and changes the default font of the Normal template.

NOTE: To create a Word document from the Windows 95 Desktop, use your right
mouse button to click the DeskTop, point to New, and choose Microsoft Word
Document. Word copies the file Winword.doc to the DeskTop and gives it a
generic name.

CAUSE
=====

A document created from the Windows Desktop is not created directly from
Word's Normal template but is created from a document that resides in the
Windows\ShellNew folder. This document is named Winword.doc and is based
on Word's Normal.dot template.

WORKAROUND
==========

Method 1: To use the Normal template's formatting in this document, use the
          Automatically Update Document Styles check box.

          a. With the right mouse button, click the Windows 95 Start
             button.

          b. Click Explore.

          c. Find the Windows\ShellNew folder.

             If you do not find the ShellNew folder under the Windows
             directory:

             1) On the Explore View menu, click Options.

             2) Click the View tab. Under Hidden Options, select Show All
                Files, and then choose OK.

          d. Select Winword.doc.

          e. From the File menu, choose Open. Word starts.



          f. On the File menu, click Templates.

          g. Click Attach. Select the Normal.dot file located in the
             MSOffice\Templates folder and click Open.

          h. Select the Automatically Update Document Styles check box, and
             click OK.

          i. On the File menu, click Save.

          j. On the File menu, click Close.

Method 2: Modify the Winword.doc file:

          a. On the Word File menu, click Open.

          b. Change the folder location to Windows\ShellNew.

             If you do not find the ShellNew folder under the Windows
             directory:

             1) On the Explore View menu, click Options.

             2) Click the View tab. Under Hidden Options, select Show All
                Files, and then choose OK.

          c. Select the Winword.doc file and click OK.

          d. With the document open, change the formatting to match the
             formatting of your Normal template.

          e. On the File menu, click Save.

          f. On the File menu, click Close.
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How to Disable In-Place Editing in Equation Editor Via Word 95
Article ID: Q136217
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SUMMARY
=======

When you insert a Microsoft Equation 2.0 object, Equation opens with in-
place editing. This article describes how to use the RegOptions macro
supplied with Word to make Equation open in a separate window.

MORE INFORMATION
================

Use the RegOptions macro to change the Windows Registry settings that
control this behavior:

1. Activate the Macros7.dot file, which contains the RegOptions macro:

   a. On the File menu, click Templates.

   b. Click Add.

   c. Change the folder to the Winword\Macros subfolder (for example,
      C:\MSOffice\Winword\Macros).

   d. Click the Macros7.dot file to select it, and click OK. This adds the
      Macros7 template to the "Global Templates and Add-ins" box. Click OK.

   e. On the Tools menu, click Macro.

   f. In the Macros Available In list, click Macros7.dot (Global
      Template). Click OK. Click OK again.

   g. The Run Sample Macros button appears. Click this button.

2. Run the RegOptions macro by clicking the down arrow and selecting
   RegOptions from the list. Click OK.

   a. In the Section box, select Equation Editor Options.

   b. In the Option box, select ForceOpen.

   c. In the Setting box, erase Using Defaults, and type "1" (without
      the quotation marks).

   d. Click Change.

   e. Click OK.

   A message appears, stating "In order for some Word-related Registry



   settings changes to take effect, it may be necessary to exit then
   restart Word," but it is not necessary to restart Word. The next time
   you insert an Equation object in any application, it will open in its
   own window, instead of opening in-place.
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Wordbasic Commands That Are Invalid In Microsoft Binder
Article ID: Q136384
 -------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

This article lists the WordBasic commands that are known to be
invalid in Microsoft Binder. This list is generated using
CommandValid. There may be additional invalid WordBasic commands that
are not listed here.
please \* comment this article.

MORE INFORMATION
================

Micrososft Word is an MDI (Multiple Document Interface) application,
while its document object, Microsoft Binder, is not an MDI
application. This will cause 'CommandValid' to show some commands as
available that may not work in WordMail. If you encounter one of
these commands the message dialog will read:

The <command name> command is not available because this document is
in another application.

Below is a list of known invalid commands:

ChooseButtonImage
CountWindows
CopyButtonImage
DisableAutoMacros
DocClose
DocMaximize
DocMinimize
DocMove
DocRestore
DocSize
DocSplit
DocumentStatistics
EditButtonImage
FileFind
FilePrintPreview
FilePrintPreviewFullScreen
FilePrintPreviewPages
FileSaveAll
FileSendMail
FileSummaryInfo
FileTemplates
FormatAddrFonts
HelpExamplesandDemos
HelpQuickPreview
HelpWordPerfectHelp



HelpWordPerfectHelpOptions
InsertDatabase
InsertMergefield
IsMacro
Keymacro
Lockdocument
Magnifier
MailMerge
MailMergeAskToConvertChevrons
MailMergeCheck
MailMergeConvertChevrons
MailMergeCreateDataSource
MailMergeCreateHeaderSource
MailMergeDataForm
Mailmergedatasource
MailMergeEditDataSource
MailMergeEditHeaderSource
MailMergeEditMainDocument
MailMergeFindRecord
MailMergeFirstRecord
Mailmergefoundrecord
MailMergeGoToRecord
MailMergeHelper
MailMergeInsertAsk
MailMergeInsertFillIn
MailMergeInsertIf
MailMergeInsertMergeRec
MailMergeInsertMergeSeq
MailMergeInsertNext
MailMergeInsertNextIf
MailMergeInsertSet
MailMergeInsertSkipIf
MailMergeLastRecord
Mailmergemaindocumenttype
MailMergeNextRecord
MailMergeOpenDataSource
MailMergeOpenHeaderSource
MailMergePrevRecord
MailMergeQueryOptions
MailMergeReset
Mailmergestate
MailMergeToDoc
MailMergeToPrinter
MailMergeViewData
MenuMode
NextWindow
PrevWindow
ResetButtonImage
ResetNoteSepOrNotice
SaveTemplate
ToolbarButtonName
ToolbarName
ToolbarState
ToolsCreateEnvelope
ToolsCreateLabels
ToolsCustomize
ToolsCustomizeKeyboard



ToolsCustomizeMenuBar
ToolsCustomizeMenus
WindowList
WindowNewWindow
DocumentPropertyExists
DocumentPropertyName
DocumentPropertyType
GetDocumentProperty
FilePost
MailChecknames
MailHideMessageHeader
MailMessageDelete
MailMessageForward
MailMessageMove
MailMessageNext
MailMessagePrevious
MailMessageProperties
MailMessageReply
MailMessageReplyAll
MailSelectNames
AutomaticChange
HelpMSN

The following commands are valid, but their context activates Binder
dialogs instead of Word dialogs. For example, when the command
'FileNew' is used it activates a dialog that contains the Binder
templates, not Word's templates. These commands are valid, but they
may not produce the expected results within Microsoft Binder.

FileClose
FileCloseAll
FileClosePicture
FileExit
FileNew
FileNewDefault
FileOpen
FilePageSetup
FilePreview
FilePrint
FilePrintDefault
FilePrintSetup
FileRoutingSlip
FileSave
FileSaveAs
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Table With Borders And Shading Prints Slower In Word 7.0
Article ID: Q136454
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you print a Word 7.0 document that contains a large table with
borders and/or shading to an HP Laserjet 4 printer, the document may
print significantly slower than when you print the same document from
Word 6.0 under Windows 95.

This problem does not occur when printing to an HP Laserjet IIIsi or
4si. Changing the printer driver settings does not correct the
problem; in fact, this may make the delay even more noticeable.

STATUS
======

Microsoft is researching this problem and will post new information here in
the Microsoft Knowledge Base as it becomes available.

WORKAROUND
==========

Use the HP Laserjet IIIsi or 4si printer driver.
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Callout Box Superimposed Over Mail Header In WordMail
Article ID: Q136455
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When using a callout box at the top of a WordMail message, the
callout box appears superimposed over the mail header area when you
choose Reply or Forward.

CAUSE
=====

A callout box is positioned relative to its anchor paragraph. It
works independent of the mail header and therefore is not moved or
affected by the mail header.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

WORKAROUND
==========

Method 1. Manually move the callout box.

Method 2. Position the callout so that it will not interfere with the mail
          header.
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Style Area Width Setting Not Retained
Article ID: Q136456
 --------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Word for Windows NT, version 6.0
--------------------------------------------------------------------------

SYMPTOMS
========

The Style Area Width is not retained when you reopen your document
and switch to Normal view.  This behavior occurs when you save and
close the document from Page Layout view.  By contrast, if you save
and close the document from Normal view, the Style Area Width is
preserved.  This behavior is different from the 16-bit versions of
Word for Windows.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows NT,
version 6.0 and Word for Windows 95, version 7.0. Microsoft is
researching this problem and will post new information here in the
Microsoft Knowledge Base as it becomes available.

RESOLUTION
==========

Save and close the document while you are in Normal view.

KBCategory: kbusage
KBSubcategory:
Additional reference words: word95 7.00 gone missing style area width
word7 normal page layout



Format Shortcut Displays When You Double-Click Spelling Icon
Article ID: Q136466
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SYMPTOMS
========

When you double-click the Spelling icon on the Status bar, the Format
shortcut menu appears instead of the Spelling shortcut menu.

CAUSE
=====

This behavior occurs when you spell check a selection that contains a
combination of text immediately followed by the result of a field
code, without a space separating the two.

When you double-click the Spelling icon on the Status bar, Word
selects the first misspelled word.  When there is no space between
the text and the field code, the text and the field code are treated
as one word.

STATUS
======

Microsoft has confirmed this to be a problem in Word for Windows 95
version 7.0. Microsoft is researching this problem and will post new
information here in the Microsoft Knowledge Base as it becomes
available.

RESOLUTION
==========

Place a space between the text and the field code.
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How to Add "Ignore Always" to Spelling Shortcut Menu
Article ID: Q136467
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
--------------------------------------------------------------------------

SUMMARY
=======

This article describes how to add an "Ignore Always" command to the
Spelling shortcut menu.  This command will format the selection for
no proofing so that the spelling checker will ignore the selection
the next time you check the spelling of your document.

MORE INFORMATION
================

WARNING: ANY USE BY YOU OF THE OR MACRO CODE PROVIDED IN THIS ARTICLE
IS AT YOUR OWN RISK. Microsoft provides this macro code "as is"
without warranty of any kind, either express or implied, including
but not limited to the implied warranties of merchantability and/or
fitness for a particular purpose.

Step 1. Create the Macro.  To do this,

        a. Click Macro on the Tools menu.

        b. Type the Macro Name as "ToolsSpellingIgnoreAlways" (without the
           quotation marks).

        c. Click Create.

        d. Type the following macro code between the Sub Main and End Sub
           commands:

              If SpellChecked() = 1 Then SpellChecked 0
              ToolsLanguage .Language = "0"

        e. Save and close the macro window.

Step 2. Assign the macro to the Spelling Shortcut Menu

        a. Click Customize on the Tools menu.

        b. Select the Menus tab.

        c. Select Macros from the Categories list box.

        d. Select ToolsSpellingIgnoreAlways from the Macro list.

        e. Select Spelling (Shortcut) from the Change What Menu drop-down
           list.

        f. Click Add.



        g. Click Close.

When you choose Ignore Always from the shortcut menu, the selected
text will be marked for no proofing and the spelling checker will
always ignore it.
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How to Obtain Word Viewer for Windows 95
Article ID: Q136593
----------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word Viewer for Windows 95, version 7.0
 - Microsoft Windows 95
 - Microsoft Windows NT version 3.51
----------------------------------------------------------------------

SUMMARY
=======

The text of the following article is available for download, along with
Word Viewer for Windows 95, version 7.0, on the online information sources
mentioned below. In addition to the following text, the WWW (World Wide
Web) page includes a hyperlink for automatic download of Word Viewer.

On online information services, Word Viewer for Windows 95 is available as
Wd95view.exe. The text of the following article is available as
Wd95view.txt.

MORE INFORMATION
================

      Microsoft(R) Word Viewer for Windows(R) 95
      ==========================================

Microsoft announces the release of Microsoft Word Viewer for
Windows 95, a small program that enables users who do not
own Microsoft Word for Windows to view and print Word
documents exactly as they appear in Word. Word Viewer gives
users the flexibility to view page layout, zoom, outline,
headers and footers, footnotes, and annotations. Word Viewer
allows users to read and print Word documents, but it does
not allow them to edit such files. However, users can copy
information from the document and activate OLE objects from
within Word Viewer.

Thanks to Word Viewer, people who own any version of
Microsoft Word for Windows or Word for the Macintosh(R),
versions 4.0 and later, can now share their documents with
users who do not own Microsoft Word. We encourage users to
copy Word Viewer freely and distribute it to friends and co-
workers along with documents they have created in Word
format. Instructions for distribution can be found later in
this document.

Use Word Viewer to View Word Documents Posted on the Internet
-------------------------------------------------------------

This product also allows users who want to post richly
formatted Word documents on the Internet to share such
documents with people who do not own Microsoft Word. To use



this product for viewing Word documents on the Internet,
users must configure their Internet browsing tool to
recognize Word Viewer as a helper application. Please
consult the user's manual of your browsing software to learn
how to achieve this. Documents with the extension ".doc"
will be recognized by Word Viewer as Word files.

Microsoft Word Viewer Is Freeware!
----------------------------------

This product is "freeware." Users are encouraged to copy and
distribute Word Viewer to friends and co-workers, or post it
on public electronic bulletin boards.

While Word Viewer allows you to view and print Word
documents using the look and feel of Microsoft Word, the
retail version of Microsoft Word contains all the award-
winning document creation and editing features that make
everyday word processing tasks easier. If you do not own
Microsoft Word and would like to join the 21 million users
who have made it the world's best selling word processor,
please contact Microsoft Sales Information Center at (800)
426-9400 for pre-sales information in the United States. If
you are outside the United States, contact the Microsoft
subsidiary for your area. To locate your subsidiary, call
the Microsoft International Sales Information Center at
(206) 936-8661.

System Requirements for Using Word Viewer
-----------------------------------------

 - A personal computer with a 386DX or higher processor
 - Microsoft Windows 95 operating system or Microsoft
   Windows NT(TM) Workstation operating system 3.51 or later
 - 4 MB of memory for Windows 95 (6 MB recommended)
 - 12 MB of memory for Windows NT Workstation
 - 3 MB of hard disk space (6 MB free for installation
   only)
 - VGA or higher resolution graphics card
 - Microsoft Mouse or compatible pointing device

Installing Microsoft Word Viewer
--------------------------------

Word Viewer for Windows 95 is available on the CD-ROM
version of Windows 95. (It is not distributed on the Windows
95 floppy disks.) On the CD-ROM, Word Viewer is located in
the Other\Wordview folder.

Word Viewer is also available for download from several
online information services, listed below under "Sources for
Word Viewer." To obtain Word Viewer, download Wd95view.exe
and place it in an empty folder on your hard disk.
Wd95view.exe is a compressed, self-extracting file. After



you download Wd95view.exe, run it to extract the files it
contains.

Read the Install.txt file, then run Setup.exe to install Word
Viewer. Note that Setup must install Word Viewer into a
different folder than the one where you extracted the files.
Setup will propose "Program Files\Wordview" as the default
location on Windows 95 (C:\WordView on Windows NT 3.51).

If Word Viewer Setup detects Word for Windows (version 6.0
or later) on your computer, it will prompt you to determine
which application should open Word documents by default. For
example, the default program is used to open files with .doc
or .dot file extensions when they are double-clicked in the
Windows 95 shell or Windows 95 Explorer. If you choose Open
With Word, Word for Windows will be used by default to open
Word files. If you choose Open With Viewer, Word Viewer will
be used by default to open Word files.

NOTE: If you choose Open With Viewer and you later want to
restore Word for Windows as the default program for Word
documents, you must run the Word for Windows (or Office for
Windows) Setup program again and choose Reinstall.

After Word Viewer is installed, you can delete the folder
you ran Setup from. However, if you plan to distribute Word
Viewer, either online or on floppy disks, you will need the
files in the original folder. See "Distributing Word Viewer"
below for more information.

To run Word Viewer, click the Start button on the Windows 95
Taskbar and point to Programs. Microsoft Word Viewer should
be located there. Alternatively, you can run Word Viewer by
double-clicking the Wordview.exe file in your
"Program Files\Wordview" folder. (On Windows NT 3.51, Setup
will create an icon for Microsoft Word Viewer, with the proposed
location being the Microsoft Office group.)

For additional information on using Word Viewer, see
Readme.doc, located in the same directory as Word Viewer. To
view this file, run Word Viewer, click Open on the File
menu, open your Word Viewer folder, click Readme.doc, and
click OK.

Distributing Word Viewer
------------------------

If you are posting Word Viewer to a Word Wide Web (WWW) home
page, please post both the Wd95view.exe and the HTML
equivalent of this document. (The HTML version can be
located at http://www.microsoft.com/msoffice/freestuff/
msword/download/viewers/viewer95/default.htm.)

If you choose to distribute Word Viewer on floppy disks, you
will need the individual files that were extracted when you
double-clicked Wd95view.exe. Copy these files (not including



Wd95view.exe) onto two formatted high-density floppy disks
for further distribution. (You will need two disks because
all the files will not fit on one disk.)

NOTE: Setup for Word Viewer can NOT be run directly from
these floppy disks. To install Word Viewer from these disks,
all the files from the two disks must be copied into one
empty folder on the hard disk. The user must then run Setup
from that folder. Please label the disks with these
instructions when distributing them to other users.

IMPORTANT: Merely copying the product files from your
installation of Word Viewer to another computer will not
install Word Viewer properly. Word Viewer must be installed
using Setup.exe to properly configure its settings in the
Registry.

Word Viewer Technical Support
-----------------------------

Technical support for Word Viewer is found in a technical
white paper that is available on FastTips, on Library 2 in
the MSWORD forum on CompuServe(R), and on the Microsoft WWW
server.

The Readme.doc in the Word Viewer folder contains an
extensive list of online sources for additional technical
support information.

Microsoft also offers Word Viewer support on the standard
Microsoft Word for Windows Product Support Services phone
line, at (206) 462-9673.

Sources for Word Viewer
=======================

Windows 95 on CD-ROM
--------------------
Word Viewer for Windows 95 is available on the CD-ROM
version of Windows 95. (It is not distributed on the Windows
95 floppy disks.) On the CD-ROM, Word Viewer is located in
the Other\Wordview folder.

The World Wide Web (WWW)
------------------------
Word Viewer is available under the "Free stuff" heading on
the Microsoft Office Home Page which can be found at
http://www.microsoft.com/msoffice/.

The Microsoft Download Service (MSDL)
-------------------------------------
If you have a modem, you can obtain Word Viewer from the
MSDL, which you can reach by calling (206) 936-6735 (936-
MSDL). The filename is Wd95view.exe. The MSDL is available
24 hours a day, 7 days a week. The highest download speed



available is 14,400 bits per second (bps). For more
information about using the MSDL, call (800) 936-4100 and
follow the prompts.

CompuServe, GEnie(TM), and Microsoft Partner Network (MSPN)
-----------------------------------------------------------
Word Viewer (Wd95view.exe) is located in the Microsoft
Software Library. (Wd95view.exe is also available in Library
2 of the MSWORD forum on CompuServe.)

The Internet
------------
On the Internet, Word Viewer is located on the Microsoft
anonymous ftp server, which you can reach by typing "ftp
ftp.microsoft.com" (without the quotation marks) at the ">"
command prompt. The Wd95view.exe file is located in the
/Softlib/Mslfiles subdirectory (notice that this path uses a
forward slash [/] instead of a backslash [\] character). To
download the file, type the following commands, pressing
ENTER after each line:

   cd /softlib/mslfiles
   bi
   get wd95view.exe

NOTE: The "bi" command changes the download protocol to
binary. By default, the Microsoft server downloads in ASCII
mode. If you download Word Viewer in ASCII mode, it will be
a corrupt file.

The Microsoft Order Desk
------------------------
To obtain Word Viewer by mail, call the Microsoft Order Desk
at (800) 360-7561. There is a shipping and handling charge
for the product. If you are outside the United States,
contact the Microsoft subsidiary for your area. To locate
your subsidiary, call the Microsoft International Sales
Information Center at (206) 936-8661. If you obtain Word
Viewer on disk from the Microsoft Order Desk, the Setup
program can be run directly from Disk 1.

===========================================================
Microsoft and Windows are registered trademarks and Windows
NT is a trademark of Microsoft Corporation.
Macintosh is a registered trademark of Apple Computer, Inc.
CompuServe is a registered trademark of CompuServe, Inc.
GEnie is a trademark of General Electric Corporation.
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Can't Seem to Use MS Access Files, *.MDB, or DDE with Word95
Article ID: Q137076
--------------------------------------------------------------------------
The information in this article applies to:

 - Microsoft Word for Windows 95, version 7.0
 - Microsoft Access, version 2.0
 - Microsoft Windows 95
--------------------------------------------------------------------------

SYMPTOMS
========

When you use the Mail Merge or Insert Database commands to obtain data from
an Access data file, the option for "MS Access Databases (*.mdb)" does not
appear in the "Files Of Type" list, and the DDE method of obtaining the
data is not available.

CAUSE
=====

In order for Word to show *.mdb files or to use DDE with Access, the Access
program directory must be listed correctly in the Windows Registry
Extensions key. Typical installations of Access update the Win.Ini file
with extension information, but information in the Win.Ini file is not to
the appropriate Registry key in Windows 95.

STATUS
======

Microsoft has confirmed this to be a problem in Word version 7.0 for
Windows 95. We are researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

RESOLUTION
==========

There are two workarounds for this problem. The first method is to add the
Access program directory to the environment path. The second method
involves correcting the extensions data key in the Windows Registry.

Method 1: Add Access to the Environment path

          1. Start WordPad.

          2. From the File menu, choose Open.

          3. In the File Name box, type "c:\autoexec.bat". Click OK.

             a. If the file is not found, click Cancel and type the
                following:

                PATH=<path to Access folder>

             where <path to Access folder> is the location of your Access
             folder, such as



                C:\OFFICE\ACCESS

             b. From the File menu, choose Exit. When asked if you want to
                save changes, answer Yes.

             c. In the File Name box, type "c:\autoexec.bat" (without
                the quotation marks).

             d. In the Save As Type box, choose "Text Document - MS-DOS
                Format".

             e. Click OK. Continue with step 7.

          4. Find the line that begins with PATH.

          5. Place the insertion point at the end of this line. Type a
             semicolon (;) and the path to the Access program folder.

          6. Save the file and exit WordPad.

          7. Restart the computer.

          Word will now be able to show *.mdb files and to use DDE.

Method 2: Correct the Registry

          For information about how to edit the registry, view the Changing
          Keys And Values online Help topic in Registry Editor
          (REGEDIT.EXE). Note that you should make a backup copy of the
          registry files (SYSTEM.DAT and USER.DAT) before you edit the
          registry.

          WARNING: Using Registry Editor incorrectly can cause serious
          problems that may require you to reinstall Windows 95. Microsoft
          cannot guarantee that problems resulting from the incorrect use
          of Registry Editor can be solved. Use Registry Editor at your own
          risk.

          1. Click the Start menu and choose Run. In the Open box, type
             "Regedit" (without the quotation marks)

          2. Open the "HK_CURRENT_USER" entry.

          3. Open the Software\Microsoft\Windows\Current Version\Extensions
             key.

          4. From the Edit Menu, choose New and select "String Value".

          5. In place of "New Value #1", type "MDB" (without quotes) and
             press Enter.

          6. Double-click on the word "MDB". A dialog box appears.

          7. Type "C:\ACCESS\MSACCESS.EXE ^.MDB" (without the quotation
             marks). Be sure this path reflects the location of Access on
             your computer. Press Enter.



          8. From the Edit Menu, choose New and select "String Value".

          9. In place of "New Value #1", type "MDA" (without the quotation
             marks) and press ENTER.

          10. Double-click on the word "MDA".

          11. Type "C:\ACCESS\MSACCESS.EXE ^.MDA" (without the quotation
              marks) and press Enter.

              The new MDA entry is not required in order for Word to use
              DDE, but it duplicates information that was in the Win.Ini
              file.
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 More Information On Knowledge Base (KB) Helpfiles
Article ID: Q199990

The KB Help file is a snapshot of the Knowledge Base
written by Product Support Engineers to help 
support Microsoft customers at the time this file was
created.

More recent KB articles can be found on Internet,
CompuServe, and GENIE. After you log on to one of these
services with your  account information, follow these steps
to find the KB:

 - On Internet, look in DESKAPPS\<product>\KB\README.TXT
 - On CompuServe, type "GO MSKB"
 - On GEnie, type "M 505"

<product> would be the name of the product you are seeking information on
such as Excel or Word.

OTHER SOURCES OF MICROSOFT SUPPORT INFORMATION

Microsoft offers Electronic Information Services as an
alternative to person-to-person support. All U.S. and
Canadian Microsoft customers have access 24 hours a day, 7
days a week to a range of free or low-cost service options
including:

Microsoft FastTips

Toll-free, automated information about key Microsoft
products. Customers have access to technical articles
(including common questions and answers) via voice, fax, and
U.S. Mail. The four categories are:

FastTips for Desktop Applications          (800)-936-4100
FastTips for Personal Operating Systems    (800)-936-4200
FastTips for Development Products          (800)-936-4300
FastTips for Advanced Systems              (800)-936-4400

Microsoft Knowledge Base

This is the primary Microsoft product information source--a
database of more than 50,000 detailed articles containing
technical information, bug lists, fix lists, and more.
Access via CompuServe, the Internet, and GEnie.

Microsoft Download Service

Direct access to Microsoft Download Library (MSDL) by modem
through the Microsoft BBS service at (206) 936-6735. Connect
information: 1200, 2400, or 9600 baud, no parity, 8 data
bits, and 1 stop.

Microsoft Forums on CompuServe



Microsoft facilitates a variety of interactive dialog forums
for its worldwide community of customers. Access by typing:
GO MICROSOFT. CompuServe connect charges apply. To establish
an information service account, contact CompuServe directly
at (800) 848-8199.

Microsoft Information Network

TechNet

Part of the support professionals program, the TechNet CD
contains resource kits, customer solution profiles, case
studies, and tips and techniques for integration. For
TechNet subscriptions, call (800) 344-2121 ext. 035.

Microsoft Developers' Network (MSDN)

Level 1 CD is a Development Library of comprehensive
development information for Win16 and Win32 APIs. Level 2 CD
contains all software needed to develop Windows-based
applications. For Microsoft Developers Network
subscriptions, call (800) 759-5474.

The Internet

Microsoft maintains a World Wide Web Site at www.microsoft.com; the 
URL is: http://www.microsoft.com/.  Once you have reached the Web site choose 
"Support for Microsoft Products", then Knowledge Base. 

You may also access the Microsoft Software Library and the Microsoft
Knowledge Base by anonymous ftp. The Microsoft Internet FTP
archive host supports anonymous login. The name of the
server is FTP.MICROSOFT.COM; the IP address is
198.105.232.1.



 




